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開始使用計算器之前

請先閱讀

關於本說明書

• 在任何情況下，卡西歐計算機株式會社不因任何人在購買本產品及所屬項

目，所引起的特殊、附帶的，或結果性的損害，而有連帶責任或任何牽

連。除此之外，卡西歐計算機株式會社對於因任何一方由於使用本產品及

其所屬項目而引起的任何求償不負有任何賠償責任。

• 本說明書的內容可能會有所更動，恕不另行通知。

• 本說明書中的顯示和說明 (例如：按鍵圖樣) 僅供說明使用，與其實際所

代表的項目可能會有些許的不同。

• QR Code 是 DENSO WAVE INCORPORATED 在日本和其他國家/地區

的註冊商標。

• 本說明書中所使用的公司和產品名稱為其個別所有者的註冊商標或商標。

按鍵操作

下列範例顯示本說明書中按鍵操作的呈現方式。

範例 1：
應依照以上所示的順序按下按鍵（由左至右）。

範例 2： (π)*
上方表示您應該依序按下  及 ，即會輸入 π 符號。所有多按鍵輸入操

作都像這樣表示。鍵帽圖樣會顯示，其後接著加上括弧的輸入字元或命令。

* 如需本說明書所使用之按鍵符號的詳細資訊，請參閱「按鍵圖樣」（第

12 頁）。

範例 3： 、 、 、 、 、
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• (1) 指示的各游標鍵以 、 、 、  表示。

• (2) 指示的各頁面捲動鍵以 、  表示。

選單操作

本說明書中的部分操作使用簡化方式說明選單操作，如下列範例所示。

範例 1

 – [Other] > [π]

或

按下 ，然後選擇 [Other] > [π]。

實際操作 1

1.按  鍵。

2.使用  和  選擇 [Other]，然後按下 。

3.使用  和  選擇 [π]，然後按下 。

範例 2

 – Calculate

或

按下 ，選擇 Calculate 應用程式圖示，然後按下 。
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實際操作 2

1.按  鍵。

2.使用游標鍵（ 、 、 、 ）選擇 Calculate 應用程式圖示，然後

按下 。

 鍵和  鍵
 鍵和  鍵的作用相同。在本說明書中，  用於選擇或套用設定，

則用於執行計算。但請注意，對於顯示  或  的操作，您不論按下 
或  都沒有差別。

範例

如果沒有指示您使用特定的計算器應用程式，或為範例操作配置特定設定，

則假設使用以下應用程式與設定。

計算器應用程式：Calculate
設定：初始預設計算器設定

如需將計算器恢復為初始預設值的詳細資訊，請參閱「初始化計算器」（第

7 頁）。

初始化計算器

重要!

• 下列程序會初始化 Contrast 和 Auto Power Off 以外的所有計算器設定。此外，這會清

除計算器記憶體中儲存的所有資料。

1.按下  顯示 HOME 畫面。

2.使用游標鍵 （ 、 、 、 ）選擇計算器應用程式圖示，然後按下

。

3.按下 ，然後選擇 [Reset] > [Initialize All] > [Yes]。
• 這會顯示 HOME 畫面。

計算器「Get Started」畫面

當顯示 HOME 畫面時，按下  鍵將會顯示「Get Started」畫面，其中包

含以下資訊。

• 用於存取 Worldwide Education Service 的「Get Started」網頁（https://
wes.casio.com/calc/cw/）的 QR Code
Get Started 網頁可讓您存取用戶說明書及其他相關資訊，幫助您開始使

用計算器。

• 計算器 ID 號碼（24 個字元的字串）
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按下  返回 HOME 畫面。

注意

• 從 SETTINGS 選單中選擇也可顯示 Get Started 畫面。請參閱「使用 SETTINGS 選
單」（第 18 頁）。

注意事項

安全注意事項

感謝您購買本 CASIO 產品。

使用前務必閱讀「安全注意事項」，確保正確使用本產品。請務必將所有用

戶文件妥善保管以便日後需要時查閱。

危險
表示有造成人員死亡或受重傷的重大危險。

 鈕扣型和硬幣型電池須知（僅限 fx-991CW）

小心確保電池不會被意外吞食。

尤其不要將電池放在幼兒能接觸到的地方。

若有人意外吞食了電池或可能意外吞食了電池，請立即去看醫生。

吞食電池可能會引起化學燒傷或粘膜組織穿透等嚴重問題，有導致死亡

事故的危險。

警告
表示有造成人員死亡或受重傷的危險。

 顯示屏畫面

請勿用力按壓液晶顯示屏或使其受到強烈的撞擊。

否則會使液晶顯示屏的玻璃破裂，有導致人員受傷的危險。

液晶顯示屏破裂時，切勿觸摸其內液體。

液晶顯示屏內的液體沾到皮膚上可能會引發炎癥。

萬一液晶顯示屏內的液體混入口中，應立即漱口並去看醫生。

萬一液晶顯示屏內的液體混入眼睛或沾到皮膚上，應用清水沖洗後去看

醫生。
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 電池須知

若電池的漏液沾到皮膚或衣服上，請立即用清潔的水沖洗。

若電池的漏液混入眼睛，有造成失明的危險。請在清洗眼睛後立即去看

醫生。

注意
表示有造成人員受輕傷或財物受損的危險。

請遵守以下事項。否則有可能造成電池破裂、引發火災、人員受傷或漏

液污染四周物品。

• 不拆解電池或使其短路。

• 不對非充電電池進行充電。

• 不加熱電池或將其丟入火中。

• 僅限使用指定類型的電池。

• 注意電池的極性（正極（＋）和負極（－）），正確裝入。

• 電池耗盡後盡快更換電池。

電池須知

請遵守以下事項。未能遵守可能導致電池爆炸或可燃液體或氣體洩

漏。

• 僅限使用本產品所指定的電池類型。

• 請勿燃燒電池或將其丟入焚化爐，或以機械方式壓碎或切割。

• 在使用、存放或搬運期間，請勿讓電池暴露於極端高溫或低溫下。

• 在使用、存放或搬運期間，請勿讓電池暴露於極低氣壓下。

使用注意事項

• fx-570CW：即使計算器一切操作都正常，仍應至少每兩年更換一次電池

（R03）。

fx-991CW：即使計算器一切操作都正常，仍應至少每兩年更換一次電池

（LR44）。

沒電的電池可能會漏液，導致計算器損壞和故障。請勿將沒電的電池留在

計算器內。請勿在電池完全沒電的時候使用計算器（fx-991CW）。

• 因電池漏液所導致的故障或損壞不在保固範圍內，須支付相關費用。

• 隨計算器所附的電池，在儲存和運送過程中可能會損失輕微的電力。由於

這個原因，它可能需要比一般正常電池壽命更短，可能需要稍早些更換。

• 避免在溫度極端、濕度高、灰塵多的地區存放或使用計算器。

• 切勿讓計算器遭受激烈碰撞、過大壓力，或甚至用力彎折計算器。
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• 切勿試圖將計算器拆開。

• 使用柔軟、清潔的乾布清潔計算器的外部。

• 丟棄計算器或電池時，請確實遵守您所在地區的法律和法規。

開始使用

安裝及拆卸前蓋

若要拆下前蓋

使用計算器前，請拆下前蓋（①）並裝到背面（②）。

若要安裝前蓋

不使用計算器時，請拆下前蓋（①）並裝到正面（②）。
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重要!

• 不使用時，務必將前蓋裝到計算器上。否則，意外操作  鍵可能導致電源開啟，而造

成電池電力耗盡。

將電源打開或關閉

按下  打開計算器。

按下 (OFF) 關閉計算器。

注意

• 若要開啟電源，請長按 。為防止意外開啟電源，  鍵的頂端略低於其他按鍵。

• 如果開啟電源後出現以下畫面，表示剩餘電池電力不足。

如果出現此畫面，請盡快更換電池。如需電池更換的詳細資訊，請參閱「更換電池」

（第 128 頁）。

• 計算器也將在大約 10 分鐘或 60 分鐘不使用後自動關閉。請按下  鍵，重新打開計

算器。
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HOME 畫面

按下  顯示 HOME 畫面。HOME 畫面會顯示已安裝計算器應用程式的清

單。

  HOME 畫面   Calculate 應用程式畫面

                 
如需已安裝計算器應用程式的詳細資訊，請參閱「已安裝計算器應用程式清

單」（第 16 頁）。

調整顯示幕對比度

1.按下 ，選擇計算器應用程式圖示，然後按下 。

2.按下 ，然後選擇 [System Settings] > [Contrast]。

3.使用  及  調整顯示幕對比度。

4.在看到您所要的設定時，按下 。

重要!

• 如果調整顯示幕對比度並沒有改善顯示幕的可讀性，很有可能是電力不足所致。請更換

電池。

按鍵圖樣

按下  鍵，接著按下第二鍵，將會執行第二鍵的第二功能。該鍵的第二功

能標示在該鍵左上方。

(1) 鍵帽功能：

(2) 第二功能： (π)
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指示符號

指示符號

下表說明畫面頂端顯示的指示符號。

指示符號： 代表意義：

因為  鍵已按下，因此所有鍵盤會使用切換後的

功能。在您按下任一鍵以後，鍵盤的切換狀態將被

解除，而這個指示符號也會消失。

在 SETTINGS 選單上，MathI/MathO 或 MathI/
DecimalO 選擇作為 Input/Output。

 /  / 
SETTINGS 選單上，Angle Unit 的目前設定

（ ：Degree、 ：Radian 或 ：Gradian）。

FIX 固定位數的有效小數位數。

SCI 固定位數的有效有效位數。

E
在 SETTINGS 選單上，On 選擇作為 Engineer
Symbol。

i /∠
SETTINGS 選單上，Complex Result 的目前設定

（i：a+bi 或 ∠：r∠θ）。

 / 
目前顯示的計算結果有上一個（ ）或下一個

（ ）計算歷史資料。在某些計算器應用程式中，

這些指示符號指示有其他的計算結果。

計算器目前完全由太陽能電池直接供電，或配合電

池供電。（僅限 fx-991CW）

使用選單

許多計算器操作是使用選單畫面執行。下列範例顯示從按下  時，顯示的

選單畫面開始的操作。
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選擇選單項目

若要選擇選單項目，請使用游標鍵（ 、 、 、 ）反白顯示該項目，

然後按下 。請注意，  和  僅在有多個選單項目欄時使用。

在選單階層之間瀏覽

選單項目右側的「 」指示符號表示，該項目下有較低的階層層級。選擇選

單項目並按下  或 ，可瀏覽階層的下一層。若要返回階層的上一層，

請按下 。

注意

• 如果位於一欄式選單的較低階層層級，除了  之外，按下  也可返回上一層。

使用選項按鈕 （ / ）選擇選單項目

當顯示幕顯示多個選項的清單時，每個項目的左側都有一個選項按鈕 （
或 ）。  表示目前選取的選項。

若要配置選項按鈕選單項目的設定

1.反白顯示適用的選單項目，然後按下 。

• 後續的操作取決於您選取的選單項目類型。

- 如果您選取的選單項目沒有其他可配置的設定，則旁邊的選項按鈕將

會變為 。

- 您選取的選單項目具有更多可配置的設定，用於選擇選單項目設定的

畫面將會顯示。在此情況下，請繼續步驟 2。
2.在設定畫面上，反白顯示您要的設定，然後按下 。
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• 這會回到步驟 1 中的選單項目畫面，而您先前選取之選單項目旁的選

項按鈕會變為 。

在畫面之間捲動

當選單項目無法全部顯示在一個畫面上時，畫面右側將會出現一個捲軸。

• 使用  和  可在畫面之間捲動。

• 使用  和  可逐行捲動。

若要關閉選單並返回選單之前顯示的畫面

按  鍵。

注意

• 您可按下 、 、 、 、 、  或按下  關閉顯示的選單。如果顯示的選

單為啟動特定計算器應用程式後出現的選單，或為應用程式專用的選單，則按下  無
法將其關閉。在此情況下，您必須按下  關閉選單。
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計算器應用程式和選單

計算器應用程式

選擇計算器應用程式

選擇適合您要執行之計算類型的計算器應用程式。

1.按下  顯示 HOME 畫面。

• 如需各計算器應用程式的詳細資訊，請參閱「已安裝計算器應用程式清

單」（第 16 頁）。

2.使用游標鍵（ 、 、 、 ）選擇您要的計算器應用程式圖示。

3.按下 ，顯示已選擇圖示之計算器應用程式的初始畫面。

已安裝計算器應用程式清單

圖示 說明

(Calculate)

一般計算

(Statistics)

統計和迴歸計算

(Distribution)

分配計算

(Spreadsheet)

試算表計算
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(Table)

根據一或兩個函數產生數字表格

(Equation)

聯立方程式、高次方程式及 Solver
（用於尋找輸入方程式中包含之任何

變數值的函數）

(Inequality)

不等式計算

(Complex)

複數計算

(Base-N)

特定數字系統的計算（二進位、八進

位、十進位、十六進位）

(Matrix)

矩陣計算

(Vector)

向量計算

(Ratio)

比例計算
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(Math Box)

下列函數支援數學學習。

Dice Roll、Coin Toss：機率模擬

使用 SETTINGS 選單

若要顯示 SETTINGS 選單，請在使用計算器應用程式時按下 。

SETTINGS 選單包含以下選單項目。

Calc Settings
包含用於配置計算設定的選單項目，例如計算結果

的顯示格式。

System Settings
包含用於配置計算器操作設定的選單項目，例如對

比度調整。

Reset 包含用於執行各種重設操作的選單項目。

Get Started
顯示 Get Started 畫面。如需詳細資訊，請參閱

「計算器『Get Started』畫面」（第 7 頁）。

注意

• 當顯示 HOME 畫面時，按下  鍵將會顯示 Get Started 畫面，而不是 SETTINGS 選
單。

• 根據計算器應用程式顯示的畫面，按下  可能不會顯示 SETTINGS 選單。

變更計算器設定

1.按下 ，選擇計算器應用程式圖示，然後按下 。

2.按下  顯示 SETTINGS 選單。

3.使用  和  選擇 Calc Settings 或 System Settings，然後按下 。

• 這會顯示已選擇選單包含之設定項目的清單。

此處畫面顯示選擇 [Calc Settings] 時，出現之內容的範例。
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• 關於 [Calc Settings] 和 [System Settings] 包含的設定項目，請參閱

「項目及可用的設定選項」（第 19 頁）。

4.使用  和  反白顯示您要變更設定的項目，然後按下 。

• 這會顯示已選擇項目的設定選項清單。

此處畫面顯示選擇 [Input/Output] 時，出現之內容的範例。

5.使用  和  反白顯示您要的選項，然後按下 。

6.在看到您所要的設定時，按下 。

項目及可用的設定選項

「◆」表示初始預設值。

Calc Settings > Input/Output

指定計算器用於表示式輸入及計算結果輸出的格式。

MathI/MathO◆
輸入：數學自然顯示；輸出：包含

分數、√  及/或 π 的格式*1

MathI/DecimalO
輸入：數學自然顯示；輸出：轉換

為小數值

LineI/LineO 輸入：線性*2；輸出：小數或分數

LineI/DecimalO
輸入：線性*2；輸出：轉換為小數

值

*1 因某些原因無法輸出這些格式時，會套用小數輸出。

*2 所有計算（包含分數和函數）以單行輸入。無數學自然顯示格式的機型

（S-V.P.A.M.機型等），亦使用與此相同的輸出格式。

輸入/輸出格式顯示範例：

MathI/MathO
（初始預設值）
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MathI/DecimalO
(Number Format：Norm 1)

(Number Format：Norm 2)

LineI/LineO

LineI/DecimalO
(Number Format：Norm 1)

Calc Settings > Angle Unit

Degree◆；Radian；Gradian
指定角度、弧度或百分度為數值輸入和計算結果顯示的角度單位。

Calc Settings > Number Format

指定顯示計算結果的位數。

Fix：您所指定的數值（從 0 到 9），控制了計算結果所要顯示的小數位

數。計算結果在顯示前會先四捨五入到指定的有效位數。

範例：1 ÷ 6
(Fix 3)

1 6 ( )*

Sci：您所指定的數值（從 1 到 10），控制了計算結果所要顯示的有效數字

位數。計算結果在顯示前會先四捨五入到指定的有效位數。

範例：1 ÷ 6
(Sci 3)

1 6 ( )*

Norm：當計算結果處於以下範圍時，以指數格式顯示計算結果。

Norm 1◆：10-2 > |x|，|x| ≥ 1010，Norm 2：10-9 > |x|，|x| ≥ 1010

20



範例：1 ÷ 200
(Norm 1)

1 200 ( )*

(Norm 2)

1 200 ( )*

* 在輸入計算式之後，按下 ( ) 鍵而不是  鍵，將會顯示小數形式

的計算結果。

Calc Settings > Engineer Symbol

On；Off◆

指定是否使用工程符號顯示計算結果。

注意

• 在此設定中選擇 On 時，指示符號（E）會顯示在畫面頂部。

Calc Settings > Fraction Result

Mixed Fraction；Improp Fraction◆

指定計算結果中的分數在顯示時，是帶分數或假分數。

Calc Settings > Complex Result

a+bi◆；r∠θ
指定用於 Complex 應用程式計算結果與 Equation 應用程式多項式解的直角

座標或極座標。

注意

• 在 Complex Result 設定中選擇 a+bi 時，i 指示符號會顯示在畫面頂部。選擇 r∠θ 時會

顯示 ∠。

21



Calc Settings > Decimal Mark

Dot◆；Comma
指定計算結果的小數點在顯示時，是句點或逗號。在輸入時始終顯示句點。

在選擇句點作為小數點時，多重結果的分隔符號為逗點 (,)。在選擇了逗點

時，分隔符號為分號 (;)。

Calc Settings > Digit Separator

On；Off◆

指定是否在計算結果中，使用分隔符號字元。

System Settings > Contrast

請參閱「調整顯示幕對比度」（第 12 頁）。

System Settings > Auto Power Off

10 Min.◆；60 Min.
指定 Auto Power Off 觸發前的時間。

System Settings > MultiLine Font

Normal Font◆；Small Font
指定在 Input/Output 中選擇 LineI/LineO，或 LineI/DecimalO 時的顯示字型

大小。選擇 Normal Font 時最多可顯示四行，選擇 Small Font 時最多可顯

示六行。

System Settings > QR Code

指定按下 (QR) 時，顯示的 QR Code 版本。

Version 3：顯示 QR Code 第 3 版。

Version 11◆：顯示 QR Code 第 11 版。

Reset > Settings & Data

請參閱「初始化計算器設定」（第 23 頁）。

Reset > Variable Memory

請參閱「清除所有記憶體中的內容」（第 35 頁）。
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Reset > Initialize All

請參閱「初始化計算器」（第 7 頁）。

Get Started

請參閱「計算器『Get Started』畫面」（第 7 頁）。

初始化計算器設定

重要!

• 下列程序會初始化 Contrast 和 Auto Power Off 以外的所有計算器設定。此外，這會清

除變數儲存器和 Ans 資料以外的所有資料。

1.按下 ，選擇計算器應用程式圖示，然後按下 。

2.按下 ，然後選擇 [Reset] > [Settings & Data] > [Yes]。
• 這會顯示 HOME 畫面。

使用 CATALOG 選單

按下  顯示 CATALOG 選單。此選單會根據目前使用的計算器應用程式及

應用程式的目前狀態（顯示的畫面或目前的設定），顯示命令、函數及符號

的類別。

範例：Calculate 應用程式的 CATALOG 選單

注意

• 如需如何從 CATALOG 選單輸入命令、函數及符號的詳細資訊，請參閱「進階計算」

（第 42 頁）。

• 如需各計算器應用程式專用命令、函數及符號的詳細資訊，請參閱「使用計算器應用程

式」（第 61 頁）中的計算器應用程式說明。

使用 TOOLS 選單

按下  時，顯示的 TOOLS 選單，包含用於執行各計算器應用程式及用於

配置設定之專用函數的選單項目。
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範例：Calculate 應用程式的 TOOLS 選單

範例：Table 應用程式的 TOOLS 選單

注意

• 以下為多個計算器應用程式的通用選單項目。

- Undo（請參閱「復原操作」（第 26 頁）。）
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輸入表示式和數值

基本輸入規則

在您按下  時，將自動判斷輸入計算式的優先順序，然後在顯示幕上顯示

結果。

4 × sin 30 × (30 + 10 × 3) = 120

*1 在輸入含括弧的函數（例如：sin 和其他函數）時，必須輸入右括弧。

*2 乘法符號 (×) 可以省略。

*3  操作之前的右括弧可以省略。

將游標移至輸入表示式的開始處和末尾處

輸入表示式時，按下  使游標跳到表示式的開始處，或按下  跳到表示式

的末尾處。

輸入表示式和計算結果「More」指示符號（ 、 ）

如果在輸入表示式行或計算結果行的右側看見指標（  或 ），表示右邊

仍有未顯示的部分。使用  和  向左及向右捲動指令行。

• 在計算結果行的右側看見  時，按下  可跳到結果的末尾處。若要跳

到計算結果行的開始處，請按下 。

• 請注意，在  和  指示符號都顯示時，如果您想要捲動輸入表示式，

您需要先按下  或  鍵，然後使用  和  鍵進行捲動。

括弧自動完成

如果執行含有省略乘法符號的乘除運算，將會如下列範例所示自動插入括

弧。

- 左括弧前或右括弧後省略乘法符號時。

範例：6 ÷ 2(1 + 2) → 6 ÷ (2(1 + 2))
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- 變數、常數等前省略乘法符號時。

範例：6 ÷ 2π → 6 ÷ (2π)

輸入限制指示

在允許輸入的位元組數還剩 10 個或更少時，游標形狀將變換為 。如果發

生這種情況，請結束計算式輸入，並按下  鍵。

使用數學自然顯示格式輸入表示式（僅
限 MathI/MathO 或 MathI/DecimalO）

透過使用按下某些鍵時，或從 CATALOG 選單輸入特定函數時顯示的符號

模版，可使用數學自然顯示格式輸入包含分數及/或特殊函數（例如 √ ）的

表示式。

範例：3 1
2  + 5 3

2
1.按下 ( ) 。

• 這會輸入帶分數範本。

2.將數值輸入至範本的整數、分子及分母區域。

3 1 2

3.執行相同操作，輸入表示式的剩餘部分。

( )5 3 2

注意

• 當輸入游標在範本（帶分數、積分 (∫) 及總和 (Σ)）的輸入區域內時，按下  會跳

到範本之後 （右側）的位置，按下  會跳到範本之前（左側）的位置。

• 由於空白框區域或所在的字元將會以深黑色顯示，因此您隨時都能辨別範本內游標的目

前位置。計算表示式中的所有其他項目將呈現深灰色。

復原操作

若要復原上一次的按鍵操作，請按下 ，選擇 [Undo]，然後按下 。
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若要取消復原您剛復原的按鍵操作，請按下 ，選擇 [Undo]，然後再次按

下 。

使用數值和表示式作為引數

範例：若要輸入 1 + 7
6 ，然後更改為 1 + 

1 7 6 (INS)

在上述範例中按下 (INS) 會使得 7
6  變為下次按鍵操作（√ ）輸入之函

數的引數。

覆寫輸入模式（僅限 LineI/LineO 或
LineI/DecimalO）

在覆寫模式下，您輸入的文字會取代目前游標位置的文字。您可執行以下操

作，在插入和覆寫模式之間切換： (INS)。在插入模式下，游標顯示為

「 」，而在覆寫模式下，游標顯示為「 」。
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基本計算

算術計算

使用 、 、  及  鍵執行算術計算。

範例：7 × 8 - 4 × 5 = 36

7 8 4 5

分數計算

請注意，分數的輸入方法取決於 SETTINGS 選單上的目前 Input/Output 設
定。

若要輸入 7
3 （假分數）

（Input/Output：MathI/MathO 或 MathI/DecimalO）

7 3 或 7 3 7
3

(Input/Output：LineI/LineO 或 LineI/DecimalO)

7 3

(a) 分子，(b) 分母

若要輸入 2 1
3 （帶分數）

（Input/Output：MathI/MathO 或 MathI/DecimalO）

( )2 1 3 2 1
3

(Input/Output：LineI/LineO 或 LineI/DecimalO)
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2 1 3

(a) 分子，(b) 分母，(c) 整數部分

範例：
2
3  + 1 1

2  = 13
6

(Input/Output：MathI/MathO)

2 3 ( )1 1 2

(Input/Output：LineI/LineO)

2 3 1 1 2

注意

• 計算結果中的分數將約分到最簡形式顯示。

若要將計算結果格式轉換為假分數或帶分數，請按下 。如需詳細資訊，

請參閱「假分數和帶分數轉換」（第 39 頁）。

分數格式計算結果

若計算結果的帶分數總位數（包括整數、分子、分母和分隔符號 ）大於

10，則無法使用分數格式顯示。在此情況下，計算結果會以小數值顯示。

範例 1：1 1 123456 = 123457 123456

(Input/Output：LineI/LineO)

1 1 123456

由於數值 1 1 123456 的總位數為 10，因此結果會以分數值顯示。

範例 2：1 1 1234567 (= 1234568 1234567) = 1.00000081

(Input/Output：LineI/LineO)

1 1 1234567

由於數值 1 1 1234567 的總位數為 11，因此結果會以小數值顯示。
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注意

• 在選擇了 MathI/MathO 以外的選項時，如果一個計算式中的數值既有分數又有小數，那

麼將會以小數值顯示結果。

乘方、方根和倒數

使用下列按鍵輸入冪次函數、方根函數及倒數函數。

冪次函數： (平方)、 (n 次方)
方根函數： (平方根)、 ( )（n 次方根）

倒數函數： ( )

範例 1：(52)3 = 15625

5 3

範例 2：(1 + 1)2+2 = 16

1 1 2 2

範例 3：√2 × 3 = 3√2 = 4.242640687...
(Input/Output：MathI/MathO)

2 3

(Input/Output：LineI/LineO)

2 3

範例 4：5√32 = 2
(Input/Output：MathI/MathO)

( ) 5 32
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(Input/Output：LineI/LineO)

5 ( ) 32

範例 5：10-1 = 1
10

(Input/Output：MathI/MathO)

10 ( )

 鍵（10 的次方）

按下  鍵與按下  具有相同作用。兩者都會輸入「×10 」

（MathI/MathO 或 MathI/DecimalO）或「×10^(」（LineI/LineO 或 LineI/
DecimalO）。

範例：1.23 × 103 = 1230

1 23 3

√  形式計算範圍

√  形式計算結果的允許顯示範圍，如下所示。

± a√b、± d ± a√b、± a√b
c  ± d√e

f
1 ≤ a < 100、1 < b < 1000、1 ≤ c < 100
0 ≤ d < 100、0 ≤ e < 1000、1 ≤ f < 100

範例：

• 10√2 + 15 × 3√3 = 45√3 + 10√2 ...以 √  形式顯示

• 99√999 (= 297√111) = 3129.089165 ...以小數值顯示

Pi、自然對數的基數 e

Pi
按下 (π) 以輸入 π。
π 顯示為 3.141592654，但是在內部計算式中使用的是 π =
3.1415926535897932384626。
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自然對數的基數 e
按下 (e) 以輸入 e。
自然對數的基數 e 顯示為 2.718281828，但是在內部計算式中使用的是 e =
2.7182818284590452353602。

計算歷史和重現

計算歷史

畫面頂端的  和／或  表示上方及／或下方有更多計算歷史內容。您可

以使用  和  鍵，捲動計算歷史內容。

支援計算歷史的應用程式：

Calculate、Complex、Base-N

範例

2 + 2 = 4

2 2

3 + 3 = 6

3 3

（往回捲動。）

注意

• 當您按下  或 、變更 Input/Output 設定或執行 Reset 操作（「Settings & Data」
或「Initialize All」）時，就會清除所有計算歷史資料。

重現

在顯示幕上出現計算結果時，您可以按下 、  或  鍵，編輯您在先前

計算式中用過的表示式。

範例

4 × 3 + 2 = 14
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4 3 2

4 × 3 - 7 = 5

（繼續） 7

注意

• 如果計算結果行的任一側或兩側顯示 （左）或 （右），可使用  和  向左及

向右捲動指令行。如果發生此情形，請先按下  或 ，然後使用  和  編輯表

示式。

使用記憶功能

答案儲存器 (Ans)
最後一次獲得的計算結果會儲存在 Ans (答案) 儲存器中。

使用 Ans 儲存器執行連續計算

範例：將 3 × 4 的結果除以 30

3 4

（繼續） 30

將 Ans 儲存器內容輸入至表示式

範例：執行下列顯示的計算式：

123 456

（繼續）  789

33



變數（A、B、C、D、E、F、x、y、z）

您可將數值儲存至變數，並在計算中使用變數。

變數清單畫面

按下  會顯示一個畫面，其中顯示目前儲存至變數 A、B、C、D、E、
F、x、y 及 z 的值。在此畫面上，數值永遠以「Norm 1」Number Format
顯示。若要關閉畫面，請按下  或 。

範例 1：若要將 3 + 5 的結果儲存至變數 A
1.執行計算。

3 5

2.按下 ，然後選擇 [A=] > [Store]。
• 這會將 3 + 5 的結果（得到 8）儲存至變數 A。

3.按  鍵。

範例 2：若要將變數 A 的內容變更為 1
1.按下 ，然後反白顯示 [A=]。

2.按  鍵。

• 這會顯示已輸入 1 的編輯畫面。

3.按  鍵。

注意

• 您可按下  並選擇 [Edit] 取代上述步驟 2 中的操作。這會顯示無任何輸入內容的編輯

畫面。輸入您要的值，然後按下 。
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• 當您在變數清單畫面上反白顯示某個變數時，如果出現鎖定（ ）圖示，表示無法編輯

反白顯示的變數。

範例 3：若要喚起變數 A 中的內容

（接續範例 1 的步驟 2）
1.按下 ，然後選擇 [A=] > [Recall]。

• 這會輸入「A」。

2.按  鍵。

• 這會調用變數 A 的值。

範例 4：若要將變數 A 的內容乘以 10
（接續範例 1 的步驟 2）

(A)* 10

* 輸入此處所示的變數：按下  並按下所需變數名稱的對應按鍵。若要輸

入 x 作為變數名稱，可按下 (x) 或 。

清除所有記憶體中的內容

即使您按下 、變更計算器應用程式或關閉計算器，Ans 儲存器和變數內

容都會保留。

當您想要清除記憶體內的所有內容時，請執行下列程序。

1.按下 ，選擇計算器應用程式圖示，然後按下 。

2.按下 ，然後選擇 [Reset] > [Variable Memory] > [Yes]。
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變更計算結果格式

使用 FORMAT 選單

您可使用按下  時顯示的 FORMAT 選單，將顯示的計算結果轉換為各種

格式。

FORMAT 選單清單

此選單項目： 轉換為此格式：

Standard Standard（包含分數、π、√  格式。）

Decimal 十進位

Prime Factor 質因數分解

Rectangular Coord 直角座標

Polar Coord 極座標

Improper Fraction 假分數

Mixed Fraction 帶分數

ENG Notation
工程記數法（a×10n 格式，n = 可被 3
整除的指數）

Sexagesimal 度、分、秒（六十進位）

注意

• 按下  時顯示的選單項目，取決於目前顯示的計算結果。此外，如果顯示無法轉換的

計算結果，則按下  時將不會顯示選單。
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轉換操作範例

範例：3 ÷ 2 = 3
2  = 1.5 = 1 1

2
在此範例中，我們將顯示為假分數的計算結果轉換為小數值，再轉換為帶分

數。最後，我們將取消轉換，並返回原始計算結果。

（Input/Output：MathI/MathO，Fraction Result：Improp Fraction）

1.執行計算 3 ÷ 2。

3 2

2.若要將計算結果轉換為小數值，請按下 ，選擇 [Decimal]，然後按下

。

3.若要將計算結果轉換為帶分數，請按下 ，選擇 [Mixed Fraction]，然後

按下 。

4.若要取消轉換，請按下 。

• 這會顯示步驟 1 的原始計算結果。

Standard 和 Decimal 轉換

Standard 格式會盡可能以包含分數、√  或 π 的形式顯示計算結果。

Decimal 格式會以小數值顯示計算結果。

注意

• 在 SETTINGS 選單上將 MathI/MathO 或 MathI/DecimalO 選擇作為 Input/Output 時，

可轉換為包含 √  或 π 的 Standard 格式。

您可使用下列操作將計算結果轉換為 Standard 或 Decimal 格式。
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範例：π ÷ 6 = 1
6  π = 0.5235987756 (Input/Output：MathI/MathO)

(π) 6

（選擇 [Decimal]。）

（轉換為小數值。）

（轉換為 Standard 格式。）

重要!

• 對於某些計算結果，選擇 FORMAT 選單上的 [Standard] 將無法轉換顯示的數值。

若要在選擇 MathI/MathO 或 LineI/LineO 時求得小數值計算結果

輸入計算式後按下 ( )，而不是按下 。

質因數分解

在 Calculate 應用程式中，可以將一個不超過 10 位數的正整數作為質因

數。

範例：對 1014 進行質因數分解

1014

 – [Prime Factor]
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注意

• 下述數值類型即使小於或等於 10 位數時也無法分解。

- 數值有任一質因數大於或等於 1,018,081。
- 數值有兩或多個質因數大於三位數。

• 無法分解的部分會在顯示時放在括弧中。

範例：2036162 = 2 × (1018081)*
*1018081 = 10092

2036162
 – [Prime Factor]

直角和極座標轉換

您可將複數計算結果轉換為直角座標（  – [Rectangular Coord]）或極座

標（  – [Polar Coord]）。在下列任一情況下，可執行此轉換操作。

• 顯示 Equation 應用程式高次方程式解時（前提是已在 Equation 應用程式

的  – [Complex Roots] 設定中選擇 On）
• 顯示 Complex 應用程式計算結果時

如需轉換操作的實際範例，請參閱下列章節。

「將複數解轉換為直角或極座標」（第 96 頁）

「將複數計算結果轉換為直角或極座標」（第 101 頁）

假分數和帶分數轉換

您可將目前顯示的分數或小數值（可透過本計算器轉換為分數的小數值）計

算結果轉換為帶分數或假分數。

範例 1：13
4  = 3 1

4
（Input/Output：MathI/MathO，Fraction Result：Improp Fraction）

13 4

 – [Mixed Fraction]

 – [Improper Fraction]

範例 2：3.25 = 13
4  = 3 1

4  (Input/Output：LineI/LineO)

3 25
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 – [Improper Fraction]

 – [Mixed Fraction]

工程記數法

您可將顯示計算結果值的指數部分轉換為 10 的次方（3 的倍數），並顯示

結果。

範例：若要將數值 1234 轉換成工程記數法，只要將小數點移動到右邊，然

後移到左邊即可。

1.輸入 1234，然後按下 。

2.執行下列操作，進入 ENG 轉換模式。

 – [ENG Notation]

• 進入 ENG 轉換模式會將計算結果轉換為工程記數法，並在右側顯示

。

• 在 ENG 轉換模式中，可使用  和  移動尾數的小數點。

3.若要退出 ENG 轉換模式，請按下 。

• 這會退出 ENG 轉換模式，並使  從顯示幕消失。

• 您也可按下  或  退出 ENG 轉換模式。
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注意

• 在 ENG 轉換模式中，無法執行一般計算。若要開始新的計算，請退出 ENG 轉換模

式。

• 工程記數法也可使用工程符號顯示。如需詳細資訊，請參閱「工程符號」（第 51
頁）。

六十進位轉換（度、分、秒計算）

您可將十進位值計算結果轉換為六十進位值。

將十進位值計算結果轉換為六十進位值

範例：1.25 = 1°15’0”

1 25

 – [Sexagesimal]

使用六十進位值輸入及計算

除了將顯示值轉換為六十進位值以外，您也可輸入六十進位值並進行計算。

下列語法用於輸入六十進位值：

{度} ( ) {分} ( ) {秒} ( )
請注意，您必須輸入度和分，即使它們是 0。

範例：若要執行 2°20’30” + 9’30” 計算。接著，將計算結果轉換為十進位

值。

2 ( )20 ( )30 ( )
0 ( )9 ( )30 ( )

（轉換為十進位值。）

 – [Decimal]

（回到六十進位顯示。）

 – [Sexagesimal]
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進階計算

本節說明所有計算器應用程式通用的命令、函數及符號。此處用於顯示命

令、函數及符號的順序，與您按下  時出現的 CATALOG 選單上顯示之內

容的順序相同。

注意

• 還有一些計算器應用程式專用的 CATALOG 選單項目未顯示於此處。如需應用程式專用

選單項目的詳細資訊，請參閱各計算器應用程式的章節。

• 根據您使用的計算器應用程式及計算器應用程式顯示的畫面，可能無法輸入某些命令、

函數或符號。無法輸入的命令、函數及符號，不會顯示在 CATALOG 選單上。

• 此處說明的命令、函數及符號，無法在 Base-N 應用程式中使用。

函數分析

本節說明執行操作後，可輸入的命令及函數：  – [Func Analysis]。

Derivative(d/dx)
Derivative(d/dx) 會求得輸入 f(x) 表示式中指定 x 座標 (a) 的近似微分係數。

注意

• 此函數可用於下列任何計算器應用程式：Calculate、Statistics、Distribution、
Spreadsheet、Table、Equation、Inequality、Matrix、Vector、Ratio。

輸入語法

輸入語法取決於 SETTINGS 選單上的 Input/Output 設定，如下表所示。

Input/Output 設定 輸入語法

MathI/MathO 或 MathI/DecimalO d
dx (f(x))|x=a

LineI/LineO 或 LineI/DecimalO d
dx (f(x), a, tol)*

* tol 指定的是公差值，當您未為 tol 輸入任何內容時，它會變成 1 × 10-16 。
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導函數計算注意事項

• 當您要在 f(x) 中使用三角函數時，請在 SETTINGS 選單上指定

「Radian」為 Angle Unit。
• 較小的 tol 值可提升精確度，但也會增加計算時間。指定 tol 時，請使用

大於或等於 1 × 10-22 的值。

• 以下可能導致不正確的結果及誤差：

- x 值的不連續點

- x 值的極端變化

- x 值包含局部最大點和局部最小點

- x 值包含拐點（轉折點）

- x 值包含不可微分的點

- 微分計算結果趨近於零

導函數計算範例

f(x) = sin(x) 時求得 f’( π
2 )（省略 tol 特定值。）

(Input/Output：MathI/MathO、Angle Unit：Radian)

 – [Func Analysis] > [Derivative(d/dx)]
(π) 2

(Input/Output：LineI/LineO、Angle Unit：Radian)

 – [Func Analysis] > [Derivative(d/dx)]
(,) (π) 2

Integration(∫)
本計算器使用數值積分的 Gauss-Kronrod 方法執行積分運算。

注意

• 此函數可用於下列任何計算器應用程式：Calculate、Statistics、Distribution、
Spreadsheet、Table、Equation、Inequality、Matrix、Vector、Ratio。

輸入語法

輸入語法取決於 SETTINGS 選單上的 Input/Output 設定，如下表所示。
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Input/Output 設定 輸入語法

MathI/MathO 或 MathI/DecimalO

LineI/LineO 或 LineI/DecimalO

* tol 指定的是公差值，當您未為 tol 輸入任何內容時，它會變成 1 × 10-10 。

積分計算注意事項

• 當您要在 f(x) 中使用三角函數時，請在 SETTINGS 選單上指定

「Radian」為 Angle Unit。
• 較小的 tol 值可提升精確度，但也會增加計算時間。指定 tol 時，請使用

大於或等於 1 × 10-22 的值。

• 根據 f(x) 的內容、積分範圍內的正/負值或積分的範圍，可能導致計算的

積分值出現大誤差。（範例：當存在不連續點或突然變化的部分時。當積

分間隔太寬時。）在這種情況下，將積分區間分成多個部分並執行計算，

可以提高計算精度。

積分計算範例

(ln(x), 1, e) = 1 （省略 tol 特定值。）

(Input/Output：MathI/MathO)

 – [Func Analysis] > [Integration(∫)]
(ln) 1 (e)

(Input/Output：LineI/LineO)

 – [Func Analysis] > [Integration(∫)]
(ln) (,)1 (,) (e)

Summation(Σ)
透過 Σ(，您可求得特定範圍的輸入 f(x) 表示式總和。

注意

• 此函數可用於下列任何計算器應用程式：Calculate、Statistics、Distribution、
Spreadsheet、Table、Equation（不包括 Solver）、Inequality、Matrix、Vector、
Ratio。
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輸入語法

輸入語法取決於 SETTINGS 選單上的 Input/Output 設定，如下表所示。

Input/Output 設定 輸入語法

MathI/MathO 或 MathI/DecimalO

LineI/LineO 或 LineI/DecimalO

* a 和 b 是可以在 -1 × 1010 < a ≤ b < 1 × 1010 範圍內指定的整數。

Σ 計算範例

 (x + 1) = 20

(Input/Output：MathI/MathO)

 – [Func Analysis] > [Summation(Σ)]
1 1 5

(Input/Output：LineI/LineO)

 – [Func Analysis] > [Summation(Σ)]
1 (,)1 (,)5

Logarithm(logab)、Logarithm(log)
使用 (log) 或  – [Func Analysis] > [Logarithm(log)] 輸入 logab 作為

log (a, b)。如果您沒有在 a 中輸入任何數值，那麼基數 10 為初始預設值。

範例 1：log101000 = log 1000 = 3

(log)1000

範例 2：log216 = 4

(log)2 (,)16
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 鍵（或  – [Func Analysis] > [Logarithm(logab)]）也可用於輸入，但

僅限在 SETTINGS 選單上選擇 MathI/MathO 或 MathI/DecimalO 作為

Input/Output 時。在這種情況下，您必須輸入一個基數值。

範例 3：log216 = 4

2 16

Natural Logarithm
使用 (ln) 或  – [Func Analysis] > [Natural Logarithm] 輸入「ln」。

範例：ln 90 (= loge90) = 4.49980967

(ln)90

機率

本節說明執行操作後，可輸入的命令及函數：  – [Probability]。

%
輸入數值並加上 % 命令會使輸入值變為百分比。

注意

• 您無法使用 Complex 應用程式輸入 %。

範例 1：150 × 20% = 30

150 20
 – [Probability] > [%]

範例 2：計算 660 是 880 的百分之多少。(75%)

660 880
 – [Probability] > [%]

範例 3：減少 3500 的 25%。(2625)
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3500 3500 25
 – [Probability] > [%]

Factorial(!)
此函數會求得零值或正整數的階乘。

範例：(5 + 3)! = 40320

5 3
 – [Probability] > [Factorial(!)]

Permutation(P)、Combination(C)
排列 (nPr) 和組合 (nCr) 函數。

範例：若要從十個人中選擇四人時，有多少種可能的排列和組合

排列：

10
 – [Probability] > [Permutation(P)]

4

組合：

10
 – [Probability] > [Combination(C)]

4

Random Number
此函數會產生 0.000 到 0.999 範圍內的虛擬隨機數。在 SETTINGS 選單

上，將 MathI/MathO 選擇作為 Input/Output 時，結果會以分數顯示。

注意

• Ran# 無法使用 Equation 應用程式的 Solver 輸入。

範例：若要獲得三位數隨機整數

1000
 – [Probability] > [Random Number]

（每次進行會有不同的結果。）
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Random Integer
此函數會在指定的起始值和結束值之間，產生虛擬隨機整數。

注意

• RanInt# 無法使用 Equation 應用程式的 Solver 輸入。

範例：若要產生 1 到 6 的隨機整數

 – [Probability] > [Random Integer]
1 (,)6

（每次進行會有不同的結果。）

數值計算

本節說明執行操作後可輸入的命令及函數：  – [Numeric Calc]。

Absolute Value
執行實數計算時，此函數只會求得絕對值。

範例：|2 - 7| = Abs(2 - 7) = 5
(Input/Output：MathI/MathO)

 – [Numeric Calc] > [Absolute Value]
2 7

(Input/Output：LineI/LineO)

 – [Numeric Calc] > [Absolute Value]
2 7

Round Off
使用 Round Off 函數（Rnd）會使引數的十進位小數值按照目前的 Number
Format 設定進行捨入。例如，當 Number Format 設定為 Fix 3 時，Rnd(10
÷ 3) 的內部及顯示結果為 3.333。使用 Norm 1 或 Norm 2 設定時，會在引

數尾數部分的第 11 位數字進行四捨五入。

範例：若要在選擇 Fix 3 作為顯示位數時執行以下計算式：10 ÷ 3 × 3 和
Rnd(10 ÷ 3) × 3
（Input/Output：MathI/DecimalO，Number Format：Fix 3）
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10 3 3

 – [Numeric Calc] > [Round Off]
10 3 3

角度單位、極/直角座標、六十進位

本節說明執行操作後，可輸入的命令、函數及符號：  – [Angle/Coord/
Sexa]。

Degrees、Radians、Gradians
這些函數用於指定角度單位。

° 表示度數，r 表示弧度，而 g 表示百分度。

您可使用下列選單項目輸入各函數。

 – [Angle/Coord/Sexa] > [Degrees]
 – [Angle/Coord/Sexa] > [Radians]
 – [Angle/Coord/Sexa] > [Gradians]

範例：π/2 弧度 = 90° (Angle Unit：Degree)

(π) 2
 – [Angle/Coord/Sexa] > [Radians]

Rect to Polar、Polar to Rect
「Pol(」將直角座標轉換為極座標，而「Rec(」則將極座標轉換為直角座

標。

• 執行計算前，請在 SETTINGS 選單上指定 Angle Unit。
• r 和 θ 和 x 和 y 的計算結果會分別儲存至變數 x 和 y。
• 計算結果 θ 的顯示範圍是 -180° < θ ≤ 180°。
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注意

• Pol( 和 Rec( 可在以下在計算器應用程式的計算畫面中使用。• 
Calculate、Statistics、Matrix、Vector

範例 1：若要將直角座標（√2, √2）轉換為極座標 （Input/Output：MathI/
MathO，Angle Unit：Degree）

 – [Angle/Coord/Sexa] > [Rect to Polar]
2 (,) 2

範例 2：若要將極座標（√2, 45°）轉換為直角座標 （Input/Output：MathI/
MathO，Angle Unit：Degree）

 – [Angle/Coord/Sexa] > [Polar to Rect]
2 (,) 45

度、分、秒

您可使用以下按鍵或選單項目，輸入六十進位符號 ( )。
( )

 – [Angle/Coord/Sexa] > [Degs Mins Secs]
如需詳細資訊，請參閱「六十進位轉換（度、分、秒計算）」（第 41
頁）。

雙曲線、三角

本節說明雙曲線和三角函數。

雙曲線函數

雙曲線函數可使用下列選單項目輸入。

 – [Hyperbolic/Trig] > [sinh]、[cosh]、[tanh]、[sinh-1]、[cosh-1] 或
[tanh-1]

角度單位設定不影響計算式。

範例：sinh 1 = 1.175201194

 – [Hyperbolic/Trig] > [sinh] 1

50



三角函數

三角函數可使用下列按鍵或選單項目輸入。

按鍵 選單項目

 – [Hyperbolic/Trig] > [sin]

 – [Hyperbolic/Trig] > [cos]

 – [Hyperbolic/Trig] > [tan]

(sin-1)  – [Hyperbolic/Trig] > [sin-1]

(cos-1)  – [Hyperbolic/Trig] > [cos-1]

(tan-1)  – [Hyperbolic/Trig] > [tan-1]

執行計算前，請在 SETTINGS 選單上指定 Angle Unit。

範例：sin 30 = 1
2  (Angle Unit：Degree)

30

工程符號

您的計算器支援 11 種工程符號（m、μ、n、p、f、k、M、G、T、P、
E），可用於數值輸入或計算結果顯示。

• 工程符號可在執行下列操作後輸入：  – [Engineer Symbol]。
• 若要顯示含工程符號的計算結果，請執行下列操作：  – [Calc Settings]

> [Engineer Symbol] > [On]。

使用工程符號的輸入及計算範例

範例 1：若要輸入 500k
(Engineer Symbol：On)

500  – [Engineer Symbol] > [Kilo] 
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範例 2：若要計算 999k (kilo) + 25k (kilo) = 1.024M (Mega) = 1024k (kilo) =
1024000
(Engineer Symbol：On)

999  – [Engineer Symbol] > [Kilo] 
25  – [Engineer Symbol] > [Kilo] 

 – [ENG Notation]
（進入 ENG 轉換模式。）

• 按下 、  或  會退出 ENG 轉換模式，並使  從顯示幕消失。若

要開始新的計算，請退出 ENG 轉換模式。

• 如需 ENG 轉換模式的詳細資訊，請參閱「工程記數法」（第 40
頁）。

科學常數

您的計算器內建 47 個科學常數。這些值是依據 CODATA (2018) 建議值。

範例：若要輸入科學常數 c（真空下的光速），並顯示其值

1.按下 ，選擇 [Sci Constants]，然後按下 。

• 這會顯示科學常數類別* 的選單。

2.選擇 [Universal]，然後按下 。

• 這會顯示 Universal 類別中的科學常數選單。

3.選擇 [c]，然後按下 。
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4.按  鍵。

* 下表顯示各類別包含的科學常數。

類別 科學常數

Universal
h、 、c、ε0、μ0、Z0、G、lP、
tP

Electromagnetic μN、μB、e、Φ0、G0、KJ、RK

Atomic&Nuclear
mp、mn、me、mμ、a0、α、re、

λC、γp、λCp、λCn、R∞、μp、μe、

μn、μμ、mτ

Physico-Chem
mu、F、NA、k、Vm、R、c1、

c2、σ

Adopted Values gn、atm、RK-90、KJ-90

Other t

單位轉換

您可使用單位轉換命令轉換測量單位。轉換公式的資料是以「NIST Special
Publication 811 (2008)」為基準。

範例：若要將 5 公分轉換為英寸（Input/Output：LineI/LineO）

1.輸入要轉換的值。

5

2.按下 ，選擇 [Unit Conversions]，然後按下 。

• 這會顯示單位轉換類別* 的選單。

3.選擇 [Length]，然後按下 。

• 這會顯示 Length 類別中的轉換命令選單。
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4.選擇 [cm in]（公分到英寸轉換命令），然後按下 。

5.按  鍵。

* 下表顯示各類別包含的單位轉換命令。

類別 單位轉換命令

Length

in cm、cm in、ft m、m ft、yd
m、m yd、mile km、km mile、n
mile m、m n mile、pc km、km
pc

Area acre m2、m2 acre

Volume
gal(US) L、L gal(US)、gal(UK)
L、L gal(UK)

Mass oz g、g oz、lb kg、kg lb

Velocity km/h m/s、m/s km/h

Pressure

atm Pa、Pa atm、mmHg Pa、Pa
mmHg、kgf/cm2 Pa、

Pa kgf/cm2、lbf/in2 kPa、
kPa lbf/in2

Energy
kgf m J、J kgf m、J cal15、cal15

J

Power hp kW、kW hp

Temperature °F °C、°C °F
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*1

*2

*3

其他

可使用計算器按鍵輸入的函數和符號，也可使用 [Other] 選單輸入。使用

 – [Other] 顯示函數和符號選單。例如，若要輸入 Ans，您可按下  或
執行下列操作：  – [Other] > [Ans]。
下表顯示對應至各按鍵操作的 [Other] 選單項目。

選單項目 按鍵

Ans

π (π)

e (e)

√ (

x√ ( ( )

-1 ( )

2

^(

- ((-))

, (,)

(

)

*1 倒數

*2 平方

*3 減號
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登錄及使用 f(x) 和 g(x) 的定義方
程式

登錄及使用 f(x) 和 g(x) 的定義方程式

本計算器包含「f(」和「g(」函數，登錄其定義方程式後，就能使用。例

如，將 f(x) = x2 + 1 登錄為「f(」函數的定義方程式後，您可計算 f(0) = 1 及
f(5) = 26。
按下  顯示用於登錄 f(x) 或 g(x) 的定義方程式，以及用於輸入「f(」或

「g(」的選單。

注意

• Table 應用程式中的 f(x) 和 g(x)，也會使用 f(x) 和 g(x) 的定義方程式。如需 Table 應用

程式的詳細資訊，請參閱「建立數字表格」（第 88 頁）。

登錄定義方程式

範例 1：若要登錄 f(x) = x2 + 1
1.按下 ，選擇 Calculate 應用程式圖示，然後按下 。

2.按下 ，然後選擇 [Define f(x)]。
• 這會顯示 f(x) 方程式登錄畫面。

3.輸入 x2 + 1。

1

4.按  鍵。

• 這會登錄您輸入的表示式，並重新顯示您在此程序的步驟 2 中，按下

 之前顯示的畫面。

注意

• 定義方程式可從 Distribution、Equation（Simul Equation / Polynomial）、Inequality、
Base-N、Ratio 及 Math Box 以外的任何計算器應用程式進行登錄。不過，根據計算器

應用程式顯示的畫面（例如，如果顯示選單畫面），則按下  時可能不會顯示選單。
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將數值指派至已登錄的定義方程式執行計算

範例 2：若要指派 x = 3 至您在範例 1 中登錄的 f(x)
（接續範例 1）
1.按下 ，然後選擇 [f(x)]。

• 這會輸入「f(」。

2.指派數值 3，然後執行計算。

3

登錄複合函數

範例 3：若要將在範例 1 中定義的 f(x) 插入至 g(x)，以登錄 g(x) = f(x) × 2 -
x
（接續範例 1）
1.按下 ，然後選擇 [Define g(x)]。

• 這會顯示 g(x) 方程式登錄畫面。

2.輸入 f(x) × 2 - x。

* 2

* 在顯示 g(x) 方程式登錄畫面時按下 ，唯一顯示的選單項目為 [f(x)]。
以相同的方式，在顯示 f(x) 方程式登錄畫面時按下 ，唯一顯示的選

單項目為 [g(x)]。
3.按  鍵。

• 這會登錄您輸入的方程式，並回到您從步驟 1 開始此操作之前顯示的

畫面。

注意

• 將數值指派至 g(x) 的 x 並計算結果的操作，與「將數值指派至已登錄的定義方程式執行

計算」（第 57 頁）下的操作相同。但請注意，您應該在步驟 1 中選擇 [g(x)]，而不是選

擇 [f(x)]。
• 在範例 3 的操作中，您將 f(x) 輸入至 g(x) 的定義方程式。相反地，您也可將 g(x) 輸入

至 f(x) 定義方程式。然而，不要同時將 g(x) 輸入至 f(x) 及將 f(x) 輸入至 g(x)。如果這樣

做，則使用 f(x) 或 g(x) 執行計算時，將會發生 Circular ERROR。

資料保留

執行下列任何操作會導致刪除已登錄至 f(x) 和 g(x) 的定義方程式。

• 按下 。
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• 使用 SETTINGS 選單在 MathI*1 與 LineI*2 之間，切換 Input/Output 設
定。

*1 MathI/MathO 或 MathI/DecimalO
*2 LineI/LineO 或 LineI/DecimalO

• 執行  – [Reset] > [Settings & Data] 或  – [Reset] > [Initialize All]
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使用 QR Code 功能

使用 QR Code 功能

您的計算器可顯示智慧型裝置可讀取的 QR Code 符號。

重要!

• 本節中的操作假設使用的智慧型裝置，具有能讀取多種 QR Code 符號的 QR Code 讀
取器，並可連上網際網路。

• 使用智慧型裝置掃描本計算器顯示的 QR Code，可讓智慧型裝置開啟 CASIO 網站。

注意

• 每當在下列任何畫面顯示時按下 (QR)，QR Code 會顯示在顯示幕上。

- HOME 畫面

- SETTINGS 選單畫面

- 錯誤畫面

- 任何計算器應用程式中的計算結果畫面

- 任何計算器應用程式中的表格畫面

- Spreadsheet 應用程式畫面

如需詳細資訊，請瀏覽 CASIO 網站（https://wes.casio.com）。

顯示 QR Code
範例：若要在計算器 Calculate 應用程式的計算結果中顯示 QR Code，並

使用智慧型裝置掃描

1.在 Calculate 應用程式中，執行一些計算。

2.按下 (QR) 顯示 QR Code。
• 顯示幕右下角的數字顯示目前 QR Code 編號及 QR Code 符號的總

數。若要顯示下一個 QR Code，請按下  或 。

注意

• 若要返回上一個 QR Code，可視需要多次按下 ，或  向前捲動直到出現為

止。

3.使用智慧型裝置掃描計算器顯示幕上的 QR Code。
• 如需如何掃描 QR Code 的詳細資訊，請參閱所使用之 QR Code 讀取

器的用戶文件。

如果遇到 QR Code 掃描問題

當 QR Code 顯示時，使用  和  調整 QR Code 的顯示對比度。此對比

度調整只會影響 QR Code 顯示。
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重要!

• 根據目前使用的智慧型裝置及/或 QR Code 讀取器應用程式，可能在掃描本計算器產生

的 QR Code 符號時遇到問題。

• 當 SETTINGS 選單上的「QR Code」設定設為「Version 3」時，可顯示 QR Code 符
號的計算器應用程式會有限制。如果嘗試在不支援 QR Code 顯示的應用程式中顯示

QR Code，將會顯示「Not Supported (Version 3)」訊息。不過，透過此設定產生的

QR Code，較容易使用智慧型裝置掃描。

• 如需詳細資訊，請瀏覽 CASIO 網站（https://wes.casio.com）。
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使用計算器應用程式

統計計算

Statistics 應用程式會根據單變數（x）或雙變數（x, y）資料，計算各種統

計數值。

執行統計計算的一般程序

1.按下 ，選擇 Statistics 應用程式圖示，然後按下 。

2.在顯示的選單上，選擇 [1-Variable]（單變數）或 [2-Variable]（雙變

數），然後按下 。

• 這會顯示統計編輯畫面。

單變數

雙變數

3.視需要顯示 Freq（頻率）欄。

• 如需詳細資訊，請參閱「Freq（頻率）欄」（第 62 頁）。

4.輸入資料。

• 如需詳細資訊，請參閱「使用統計編輯畫面輸入資料」（第 62
頁）。

5.輸入資料後，按下 。

• 這時會顯示下列選單。

單變數
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雙變數

6.選擇您要執行之操作的選單項目。

• 根據您輸入的資料，選擇 [1-Var Results]、[2-Var Results] 或 [Reg
Results]，以查看計算結果的清單。如需詳細資訊，請參閱「顯示統計

計算結果」（第 65 頁）。

• 若要根據輸入資料顯示用於執行計算的統計計算畫面，請選擇

[Statistics Calc]。如需詳細資訊，請參閱「使用統計計算畫面」（第

68 頁）。

注意

• 若要從統計計算畫面返回統計編輯畫面，請依序按下  及 。

使用統計編輯畫面輸入資料

統計編輯畫面會顯示一欄、兩欄或三欄：單變數 (x)、單變數和頻率 (x,
Freq)、雙變數 (x, y)、雙變數和頻率 (x, y, Freq)。可以輸入的資料列數取決

於欄數：一欄 160 列，兩欄 80 列，三欄 53 列。

重要!

• 每當執行下列任何操作時，目前在統計編輯畫面中輸入的所有資料會被刪除。

- 在單變數與雙變數之間切換統計計算類型

- 在 TOOLS 選單上變更 Frequency 設定

• 如果資料項目的數量很大，則統計計算可能會花費一段時間。

Freq（頻率）欄

如果在 TOOLS 選單上開啟 Frequency 設定，標示為「Freq」的欄將會同

時包含在統計編輯畫面上。您可使用 Freq 欄指定各樣本值的頻率（相同樣

本在資料群組中出現的次數）。

單變數
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雙變數

若要顯示 Freq 欄
1.當顯示統計編輯畫面時，按下  並選擇 [Frequency] > [On]。
2.按下  返回統計編輯畫面。

若要隱藏 Freq 欄
1.當顯示統計編輯畫面時，按下  並選擇 [Frequency] > [Off]。
2.按下  返回統計編輯畫面。

在統計編輯畫面上輸入樣本資料的規則

您輸入的資料會插入至游標所在的儲存格中。使用游標鍵在儲存格之間移動

游標。

   游標

輸入數值後，按下 。這會在儲存格中登錄數值，並顯示最多六位數字。

範例 1：若要選擇雙變數並輸入以下資料：(170, 66)、(179, 75)、(173, 68)
1.按下 ，選擇 Statistics 應用程式圖示，然後按下 。

2.選擇 [2-Variable]，然後按下 。

3.使用下列操作輸入資料。

170 179 173
66 75 68
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注意

• 在統計編輯畫面上，您可將儲存格中的值儲存至變數。例如，在顯示上方步驟 3 中的畫

面時，執行下列操作會將 68 儲存至變數 A：  – [A=] > [Store]。如需變數的詳細

資訊，請參閱「變數（A、B、C、D、E、F、x、y、z）」（第 34 頁）。

編輯樣本資料

若要更換儲存格中的資料

在統計編輯畫面上，將游標移動到包含您想要編輯之資料的儲存格、輸入新

的資料，然後按下  鍵。

若要刪除一列

在統計編輯畫面上，將游標移動到您想要刪除的列，然後按下  鍵。

若要插入一列

1.在統計編輯畫面上，將游標移至您要插入列下方的列上。

2.執行下列操作：  – [Edit] > [Insert Row]。

若要刪除所有統計編輯畫面內容

在統計編輯畫面上，執行下列操作：  – [Edit] > [Delete All]。

排序資料

您可依 x、y 或 Freq 欄值的遞增或遞減順序，排序統計編輯畫面資料。

重要!

• 請注意，在變更資料排序順序後，您將無法將其恢復為原始順序。

範例 2：若要依 x 欄的遞增順序並依 y 欄的遞減順序，排序範例 1（第 63
頁） 中的輸入資料

1.使用範例 1 中的程序輸入資料。

2.依 x 欄的遞增順序排序資料。

 – [Sort] > [x Ascending]

3.依 y 欄的遞減順序排序資料。
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 – [Sort] > [y Descending]

顯示統計計算結果

顯示單變數統計計算結果

1-Var Results 畫面會列出根據單變數資料計算的各統計數值（例如平均值

和母體標準偏差）。本節說明顯示 1-Var Results 畫面所需的操作。

範例 3：若要輸入以下資料並顯示單變數統計計算結果

x 1 2 3 4 5 6 7 8 9 10
Freq 1 2 1 2 2 2 3 4 2 1

1.按下 ，選擇 Statistics 應用程式圖示，然後按下 。

2.選擇 [1-Variable]，然後按下 。

• 這會顯示統計編輯畫面。

3.按下 ，然後選擇 [Frequency] > [On]。
• 按下  返回統計編輯畫面。

4.將資料輸入至 x 欄。

1 2 3 4 5 6 7 8 9 10

5.將資料輸入至 Freq 欄。

2 2 2 2 3 4 2

6.按  鍵。

7.選擇 [1-Var Results]，然後按下 。

• 這會顯示 1-Var Results 畫面。
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（或 ）

（或 ）

• 關於 1-Var Results 畫面上顯示之變數的意義，請參閱「統計數值變數

和統計計算函數的清單」（第 71 頁）。

8.按下  或  返回統計編輯畫面。

顯示雙變數統計計算結果

2-Var Results 畫面會列出根據雙變數資料計算的各統計數值（例如平均值

和母體標準偏差）。本節說明顯示 2-Var Results 畫面所需的操作。

範例 4：若要輸入以下資料並顯示雙變數統計計算結果

x 1.0 1.2 1.5 1.6 1.9 2.1 2.4 2.5 2.7 3.0
y 1.0 1.1 1.2 1.3 1.4 1.5 1.6 1.7 1.8 2.0

1.按下 ，選擇 Statistics 應用程式圖示，然後按下 。

2.選擇 [2-Variable]，然後按下 。

• 這會顯示統計編輯畫面。

3.將資料輸入至 x 欄。

1 1 2 1 5 1 6 1 9
2 1 2 4 2 5 2 7 3

4.將資料輸入至 y 欄。

1 1 1 1 2 1 3 1 4
1 5 1 6 1 7 1 8 2

5.按  鍵。

6.選擇 [2-Var Results]，然後按下 。

• 這會顯示 2-Var Results 畫面。
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（或 ）

（或 ）

（或 ）

• 關於 2-Var Results 畫面上顯示之變數的意義，請參閱「統計數值變數

和統計計算函數的清單」（第 71 頁）。

7.按下  或  返回統計編輯畫面。

顯示迴歸計算結果

Reg Results 畫面會列出根據雙變數資料，計算得到的迴歸計算結果（迴歸

方程式的係數）。本節說明顯示 Reg Results 畫面所需的操作。

範例 5：若要使用在範例 4（第 66 頁） 中輸入的雙變數資料，並顯示下列

兩個迴歸計算的結果

• 對資料執行線性迴歸時，為迴歸方程式「y = a + bx」係數（a、b）及相

關係數（r）
• 對資料執行二次迴歸時，為迴歸方程式「y = a + bx + cx2」係數（a、b、

c）

注意

• 如需 Statistics 應用程式支援之迴歸計算類型的詳細資訊，請參閱「支援的迴歸類型清

單」（第 68 頁）。

1.執行範例 4（第 66 頁） 下方程序的步驟 1 至 5。
2.選擇 [Reg Results]，然後按下 。

• 這會顯示迴歸類型選單。

3.選擇 [y=a+bx]，然後按下 。

• 這會顯示線性迴歸 Reg Results 畫面。
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4.按下  或  返回統計編輯畫面。

5.按下 ，然後選擇 [Reg Results] > [y=a+bx+cx2]。
• 這會顯示二次迴歸 Reg Results 畫面。

6.按下  或  返回統計編輯畫面。

• 關於 Reg Results 畫面上顯示之變數的意義，請參閱「統計數值變數和

統計計算函數的清單」（第 71 頁）。

支援的迴歸類型清單

迴歸類型
迴歸方程式

（迴歸類型選單項目）

線性迴歸 y = a + bx

二次迴歸 y = a + bx + cx2

對數迴歸 y = a + b･ln(x)

e 指數迴歸 y = a･e^(bx)

ab 指數迴歸 y = a･b^x

冪次迴歸 y = a･x^b

倒數迴歸 y = a + b/x

使用統計計算畫面

您可使用統計計算畫面調用各統計數值，並在計算中使用數值。

無計算表示式輸入的畫面
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計算範例

若要調用統計數值，請使用代表您要調用之統計數值的變數（例如，x 平均

值：x、x 母體標準偏差：σx、x 最大值：max(x) 等等）。如需這些變數的

詳細資訊，請參閱「統計數值變數和統計計算函數的清單」（第 71
頁）。

顯示統計計算畫面

單變數

1.當顯示統計計算畫面時，按下 。

2.在顯示的選單上，選擇 [Statistics Calc] 並按下 。

雙變數

1.當顯示統計計算畫面時，按下 。

2.在顯示的選單上，選擇 [Statistics Calc] 並按下 。

• 這會顯示迴歸類型選單（請參閱「支援的迴歸類型清單」（第 68
頁））。

3.在選單上，選擇您要的迴歸類型，然後按下 。

• 在上述範例中，使用顯示的選單選擇 [y=a+bx]（線性迴歸）。

若要從統計計算畫面返回統計編輯畫面

依序按下  和 。
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使用統計計算畫面的計算範例

範例 6：若要求得範例 3（第 65 頁） 中單變數資料輸入的樣本資料總和

（Σx）及平均值（x）
1.執行範例 3（第 65 頁） 下方程序的步驟 1 至 6。
2.選擇 [Statistics Calc]，然後按下 。

3.計算樣本資料總和（Σx）。

 – [Statistics] > [Summation] > [Σx]

4.計算平均值（x）。

 – [Statistics] >
[Mean/Var/Dev...] > [x]

注意

• 若要從上方的統計計算畫面顯示 1-Var Results 畫面，請按下  並選擇 [1-Var
Results]。若要從 1-Var Results 畫面返回統計計算畫面，請按下  或 。

範例 7：若要根據範例 4（第 66 頁） 中的雙變數資料輸入求得線性迴歸方

程式「y = a + bx」的係數（a、b）和相關係數（r）
1.執行範例 4（第 66 頁） 下方程序的步驟 1 至 5。
2.選擇 [Statistics Calc]，然後按下 。

• 這會顯示迴歸類型選單。

3.選擇 [y=a+bx]，然後按下 。

4.求得線性迴歸方程式「y = a + bx」的係數（a、b）和相關係數（r）。
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 – [Statistics] > [Regression] > [a]

 – [Statistics] > [Regression] > [b]

 – [Statistics] > [Regression] > [r]

• 若要選擇其他迴歸類型，請按下  並選擇 [Select Reg Type]。這會顯

示步驟 2 的迴歸類型選單。

若要從統計計算畫面顯示 2-Var Results 畫面

按下 ，然後選擇 [2-Var Results]。

若要從統計計算畫面顯示 Reg Results 畫面

按下 ，然後選擇 [Reg Results]。

統計數值變數和統計計算函數的清單

您可使用 CATALOG 選單調用代表統計數值的變數，以及用於統計計算的

函數。

注意

• 對於單變數統計計算，您可以使用標有星號（*）的變數。

• 關於各變數和命令使用的計算公式，請參閱「統計計算公式」（第 74 頁）。

 – [Statistics] > [Summation]
Σx*、Σy ...... 樣本資料的總和

Σx2*、Σy2 ...... 樣本資料的平方和

Σxy ...... x 資料和 y 資料的積項和

Σx3 ...... x 資料的立方和

Σx2y ...... (x 資料平方 × y 資料) 的總和

Σx4 ...... x 資料的複二次總和

 – [Statistics] > [Mean/Var/Dev...]
x*、y ...... 平均值

σ2x*、σ2y ...... 母體變異數

σx*、σy ...... 母體標準偏差

s2x*、s2y ...... 樣本變異數

sx*、sy ...... 樣本標準偏差
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n* ...... 項目數量

 – [Statistics] > [Min/Max/Quartile]（僅限單變數資料）

min(x)* ...... 最小值

Q1* ...... 第一四分位數

Med* ...... 中位數

Q3* ...... 第三四分位數

max(x)* ...... 最大值

 – [Statistics] > [Norm Dist]（僅限單變數資料）

P(*、Q(*、R(*、 t* ......用於執行常態分配計算的函數。如需這些函數的

詳細資訊，請參閱「執行常態分配計算（僅限單變數資料）」（第 72
頁）。

 – [Statistics] > [Min/Max]（僅限雙變數資料）

min(x)、min(y) ...... 最小值

max(x)、max(y) ...... 最大值

 – [Statistics] > [Regression]（僅限雙變數資料）

用於二次迴歸

a、b、c ...... 二次迴歸的迴歸係數

x̂1、x̂2 ......用於求得 y 輸入值之 x1 和 x2 估計值的函數。對於引數，在 x̂1

或 x̂2 函數之前輸入 y 的值。

ŷ ......用於求得 x 輸入值之 y 估計值的函數。對於引數，在此函數之前輸

入 x 的值。

用於非二次迴歸

a、b ...... 迴歸係數

r ...... 相關係數

x̂ ......用於求得 y 輸入值之 x 估計值的函數。對於引數，在此函數之前輸

入 y 的值。

ŷ ......用於求得 x 輸入值之 y 估計值的函數。對於引數，在此函數之前輸

入 x 的值。

如需求得估計值的操作範例，請參閱「計算估計值（僅限雙變數資料）」

（第 73 頁）。

執行常態分配計算（僅限單變數資料）

選擇單變數的統計計算時，您可以在按下  並選擇 [Statistics] > [Norm
Dist] 時，從顯示的選單中使用下列函數執行常態分配計算。

P(、Q(、R( ...這些函數會使用 t 作為引數，並判定標準常態分配的可能

性，如下圖所示。
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t ......此函數前面有引數 x。這會根據統計計算畫面的輸入資料，使用平均

值（x）和母體標準偏差（σx）計算資料值 x 的標準變量。

範例 8：對於範例 3（第 65 頁） 中的單變數資料輸入，求得 x = 2 時的標

準化變量，以及該點的 P(t)。
1.執行範例 3（第 65 頁） 下方程序的步驟 1 至 6。
2.選擇 [Statistics Calc]，然後按下 。

3.計算 x = 2 時的標準化變量。

2
 – [Statistics] > [Norm Dist] > [ t]

4.計算 P(t)。

 – [Statistics] > [Norm Dist] > [P(]

計算估計值（僅限雙變數資料）

根據雙變數統計計算中獲得的迴歸方程式，可計算給定 x 值的 y 估計值。根

據迴歸方程式中的 y 值，同樣可以計算相應的 x 值（兩個值，x1 和 x2，根

據二次迴歸）。

範例 9：在範例 4（第 66 頁） 中資料輸入的線性迴歸所產生的迴歸方程式

中，x = 5.5 時，計算 y 的估計值

1.執行範例 4（第 66 頁） 下方程序的步驟 1 至 5。
2.選擇 [Statistics Calc]，然後按下 。

• 這會顯示迴歸類型選單。
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3.選擇 [y=a+bx]，然後按下 。

4.輸入 x 值（5.5），然後輸入「ŷ」，這是用於求得 y 估計值的函數。

5 5
 – [Statistics] > [Regression] > [ŷ]

5.按  鍵。

統計計算公式

單變數統計計算公式

雙變數統計計算公式

迴歸計算公式

線性迴歸（y = a + bx）
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二次迴歸（y = a + bx + cx2）

對數迴歸（y = a + b･ln(x)）

e 指數迴歸（y = a･e^(bx)）

75



ab 指數迴歸（y = a･b^x）

冪次迴歸（y = a･x^b）

倒數迴歸（y = a + b/x）
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分配計算

在 Distribution 應用程式中，您可選擇分配計算類型並輸入各參數以得到機

率值。* 可執行的分配計算類型如下表所示。

分配計算類型 選單項目

二項式機率 Binomial PD

二項式累積機率 Binomial CD

常態機率密度 Normal PD

常態累積機率 Normal CD

反向常態累積分配* Inverse Normal

波氏機率 Poisson PD

波氏累積機率 Poisson CD

*「Inverse Normal」會執行反向計算，從機率值（Area）求得資料值

（xInv）。

執行分配計算的一般程序

範例：若要在 N（試驗次數）= 5 且 p（成功機率）= 0.5 時計算 x 資料 {2,
3, 4, 5} 的二項式累積機率

1.按下 ，選擇 Distribution 應用程式圖示，然後按下 。

• 這會顯示分配計算類型選單。

2.在選單上，選擇一種分配計算類型。

• 此處我們想計算二項式累積機率。選擇 [Binomial CD]，然後按下 。

3.在顯示的選單上，選擇資料（x）輸入方法。
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[List] ...選擇可同時輸入多個 x 資料項目。選擇此選單會顯示清單畫面。

[Variable] ...選擇可輸入單一 x 資料項目。選擇此選單會顯示參數輸入畫

面。

• 此處我們想同時輸入多個 x 資料項目，選擇 [List] 並按下 。

4.在清單畫面上，輸入 x 資料 {2, 3, 4, 5}。

2 3 4 5

5.按  鍵。

• 這會顯示 Binomial CD 參數輸入畫面。

6.輸入參數的值（N = 5，p = 0.5）。

5 0 5

• 需要資料輸入的參數取決於您在此程序的步驟 2 中選擇的計算類型。

如需詳細資訊，請參閱「參數清單」（第 79 頁）。

7.輸入所有變數的值後，選擇 [Execute] 並按下 。

• 這會顯示計算結果畫面。

• 如果在步驟 3 中選擇 [List]，計算結果（P 欄）將會顯示在清單畫面

上。如需詳細資訊，請參閱「清單畫面」（第 79 頁）。

• 當計算結果顯示時，如果在清單畫面上執行任何編輯操作（請參閱「編

輯清單畫面內容」（第 80 頁）），計算結果將會被清除。清單將會

回到在此程序步驟 4 中的狀態（清單畫面資料輸入完成）。

• 如果輸入值超過允許範圍，則會顯示錯誤訊息。當對應資料的輸入值超

過允許範圍時，計算結果畫面的 P 欄將會顯示「ERROR」。

• 在顯示計算結果畫面時按下 ，將返回參數輸入畫面。

注意

• 如果在上述步驟 2 中選擇 Normal PD、Normal CD 或 Inverse Normal，則資料（x）輸

入方法永遠為「Variable」（單一 x 資料項目輸入）。因此，這時不會顯示步驟 3 中的

選單。

• 如果資料（x）輸入方法為「Variable」，計算結果將會儲存至 Ans 儲存器。

78



• 分配計算準確度最多為 6 位有效數字。

參數清單

下列清單顯示在參數輸入畫面上顯示之符號的意義。

Binomial PD、Binomial CD
x … 資料

N … 試驗次數

p … 成功機率（0 ≤ p ≤ 1）

Normal PD
x … 資料

μ … 母體平均值

σ … 母體標準偏差（σ > 0）

Normal CD
Lower … 下限

Upper … 上限

μ … 母體平均值

σ … 母體標準偏差（σ > 0）

Inverse Normal
Area … 機率值（0 ≤ Area ≤ 1）
μ … 母體平均值

σ … 母體標準偏差（σ > 0）
（尾部設定永遠在左側。）

Poisson PD、Poisson CD
x … 資料

λ … 平均值

注意

• 不論輸入資料的輸入畫面為何，每個參數名稱的上次數值輸入都會保留。例如，在

Binomial PD 參數輸入畫面上輸入 N 的值也會變更 Binomial CD 參數輸入畫面上的 N
值。

• 您在每個參數輸入的值都會保留，直到執行下列操作為止：  – [Reset] > [Settings &
Data] 或  – [Reset] > [Initialize All]。

清單畫面

您可使用清單畫面輸入最多 45 個 x 資料項目。計算結果也會顯示在清單畫

面上。
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(1) 分配計算類型

(2) 目前游標位置的值

(3) 資料（x）
(4) 計算結果（P）

注意

• 在清單畫面上，您可將儲存格中的值儲存至變數。例如，在顯示上方畫面時，執行下列

操作會將 1 儲存至變數 A：  – [A=] > [Store]。如需變數的詳細資訊，請參閱「變數

（A、B、C、D、E、F、x、y、z）」（第 34 頁）。

• 執行下列任一操作會刪除在清單畫面上輸入的所有 x 資料。

- 返回 HOME 畫面並啟動其他計算器應用程式

- 執行 [Delete All]（請參閱「若要刪除所有清單畫面內容」（第 81 頁）。）

- 執行  – [Reset] > [Settings & Data] 或  – [Reset] > [Initialize All]

編輯清單畫面內容

若要變更儲存格中的 x 資料

在清單畫面上，將游標移動到包含您想要更改資料的儲存格，輸入新的資

料，然後按下  鍵。

若要刪除一列

在清單畫面上，將游標移動到您想要刪除的列，然後按下  鍵。

若要插入一列

1.在清單畫面上，將游標移至您要插入列下方的列上。

2.執行下列操作：  – [Edit] > [Insert Row]。
• 這會插入一列並輸入 0，作為初始預設值。

3.輸入資料。
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若要刪除所有清單畫面內容

在清單畫面上，執行下列操作：  – [Edit] > [Delete All]。

計算範例

若要在 x = 36、μ = 35、σ = 2 時計算常態機率密度

1.按下 ，選擇 Distribution 應用程式圖示，然後按下 。

2.在顯示的分配計算類型選單上，選擇 [Normal PD] 並按下 。

• 這會顯示 Normal PD 參數輸入畫面。

3.輸入參數的值（x = 36、μ = 35、σ = 2）。

36 35 2

4.按  鍵。

• 再次按下  或按下  或  返回此程序的步驟 3 中的參數輸入畫

面。

• 您可將目前顯示的計算結果儲存至變數。例如，在顯示上方步驟 4 中
的畫面時，執行下列操作會將計算結果儲存至變數 A：  – [A=] >
[Store]。如需變數的詳細資訊，請參閱「變數（A、B、C、D、E、
F、x、y、z）」（第 34 頁）。

使用試算表

Spreadsheet 應用程式可使用 45 列 × 5 欄（儲存格 A1 至 E45）試算表執

行計算。

若要進行本節中的操作，請先啟動 Spreadsheet 應用程式。按下 ，選擇

Spreadsheet 應用程式圖示，然後按下 。這會顯示試算表畫面。

(1) 列號（1 至 45）
(2) 欄字母（A 至 E）
(3) 游標：指示目前選取的儲存格。目前選取儲存格的列號和欄字母以黑

色顯示，其他儲存格的列號和欄字母以深灰色顯示。
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(4) 編輯方塊：顯示游標目前所在儲存格的內容。

重要!

• 每當關閉計算器或按下  鍵，試算表中的所有輸入就會被清除。

輸入及編輯儲存格內容

您可將常數或公式輸入至每個儲存格內。

常數：常數是指在您完成輸入後，其數值就保持固定的內容。常數可以是數

值或計算表示式（例如 7+3、sin30、A1×2 等），其開頭不能有等號

（=）。

公式：公式的開頭會加上一個等號（=），例如 =A1×2，只要一寫入就會執

行。

注意

• 目前編輯的儲存格最多可輸入 49 個位元組（按下  確認輸入前的位元組數）。位元

組數的計算方式如下所示。

- 數字、變數、符號：每個字元 1 個位元組

- 命令、函數：各 1 個位元組

整個命令或函數計為一個位元組。例如，以下計為一個位元組：「√ (」、「Sum(」。

• 根據每個儲存格中輸入的內容，輸入確認後所佔的位元組數如下所示。

- 常數：14 個位元組，不論輸入位數*
- 公式：輸入位元組數（最多 49 個位元組）+ 15 個位元組

* 如果輸入具有 11 位以上有效數字的常數，則數值會在輸入確認後轉換為 10 位有效數

字。

範例：如果輸入 12345678915（11 位數），數值將會轉換為 1.234567892 ×
1010（10 位數）。

若要顯示剩餘輸入容量

按下 ，選擇 [Available Memory]，然後按下 。

將常數和公式輸入至儲存格

範例 1：在儲存格 A1、A2 及 A3 中，分別輸入常數 7×5、7×6 及 A2+7。
接著，將下列公式輸入至儲存格 B1：=A1+7。
1.將游標移至儲存格 A1。
2.執行下列按鍵操作。

7 5 7 6 (A) 7

3.將游標移至儲存格 B1，然後執行下列按鍵操作。
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(=) (A) 7

注意

• 在試算表畫面上，您可將儲存格中的值儲存至變數。例如，在顯示步驟 3 中的畫面時執

行下列操作，會將 42（輸入至儲存格 B1 之公式的計算結果）儲存至變數 A：  –
[A=] > [Store]。如需變數的詳細資訊，請參閱「變數（A、B、C、D、E、F、x、y、
z）」（第 34 頁）。

• 您可指定編輯方塊中的公式是否依原樣或其計算結果值顯示。請參閱「Spreadsheet 應
用程式設定項目」（第 87 頁）。

若要編輯現有的儲存格資料

1.將游標移至您要編輯內容的儲存格，然後按下  鍵。

• 您也可執行下列操作，不一定要按下 。

 – [Edit Cell]
• 編輯方塊中的儲存格內容將從靠右對齊變為靠左對齊。文字游標（|）
將會出現在編輯方塊中，可讓您編輯其內容。

2.使用  和  在儲存格內容的周圍移動文字游標，並視需要編輯。

3.若要完成並套用您的編輯，請按下 。

若要使用 Grab 命令輸入儲存格參照名稱

Grab 命令可取代手動輸入參照名稱（例如 A1），使用按鍵操作可選擇並輸

入您要參照的儲存格。

範例 2：接續範例 1，將下列公式輸入至儲存格 B2：=A2+7。
1.將游標移至儲存格 B2。
2.執行下列操作。

(=)  – [Spreadsheet] > [Grab]

7

儲存格相對及絕對參照

儲存格參照分成兩種：相對及絕對。
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相對儲存格參照

以公式 =A1+7 為例，儲存格參照（A1）為相對參照，這表示它會隨公式所

在的儲存格而改變。例如，如果公式 =A1+7 原本位於儲存格 B1，則將其複

製並貼到儲存格 C3 會使得 =B3+7 輸入至儲存格 C3。由於複製及貼上操作

會將公式移動一欄（B 至 C）和兩列（1 至 3），因此公式中的 A1 相對儲

存格參照會移動一欄和兩列到 B3。如果複製及貼上操作的結果造成相對儲

存格參照名稱變為超出試算表儲存格範圍之外的內容，則適用的欄字母和／

或列號將會被問號（?）取代，並且「ERROR」將顯示為儲存格的資料。

絕對儲存格參照

如果希望不論某一儲存格參照名稱的列或欄，或列與欄貼到哪個位置都能保

持不變，您需要建立絕對儲存格參照名稱。若要建立絕對儲存格參照，請在

欄名稱及／或列號之前輸入一個貨幣符號（ ）。您可使用三種不同的絕對

儲存格參照的任一種：絕對欄與相對列（ A1）、相對欄與絕對列（A
1）或絕對列與欄（ A 1）。

若要輸入絕對儲存格參照符號（ ）

將公式輸入至儲存格時，按下  並選擇 [Spreadsheet] > [ ]。

若要剪下並貼上試算表資料

1.將游標移至您要剪下資料的儲存格。

2.按下 ，選擇 [Cut & Paste]，然後按下 。

• 這會進入貼上準備狀態。若要取消貼上準備狀態，請按下  或 。

3.將游標移至您想貼上剛剪下之資料的儲存格，然後按下 。

• 貼上資料會同時刪除您執行剪下操作之儲存格中的資料，並自動取消貼

上準備狀態。

注意

• 在執行剪下及貼上操作的情況下，不論是相對或絕對，儲存格參照在貼上時不會變更。

若要複製並貼上試算表資料

1.將游標移至您要複製資料的儲存格。

2.按下 ，選擇 [Copy & Paste]，然後按下 。

• 這會進入貼上準備狀態。若要取消貼上準備狀態，請按下  或 。

3.將游標移至您想貼上剛複製之資料的儲存格，然後按下 。

• 在您按下  或  之前，貼上準備會保持啟用狀態，您可根據需要將

所複製的資料貼到其他儲存格。
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注意

• 在您複製包含一個採用相對參照之公式的儲存格內容時，相對參照將根據貼上內容的儲

存格位置相應變化。

若要刪除在特定儲存格中輸入的資料

將游標移至您要刪除內容的儲存格，然後按下  鍵。

若要刪除單一試算表中所有儲存格的內容

按下 ，選擇 [Delete All]，然後按下 。

使用 Spreadsheet 應用程式特殊命令

在 Spreadsheet 應用程式中，可在公式或常數中使用以下命令。這些命令

會在您按下  並選擇 [Spreadsheet] 時顯示的選單上出現。

Min(
傳回指定儲存格範圍中各數值的最小值。

語法：Min(開始儲存格:結束儲存格)

Max(
傳回指定儲存格範圍中各數值的最大值。

語法：Max(開始儲存格:結束儲存格)

Mean(
傳回指定儲存格範圍中各數值的平均值。

語法：Mean(開始儲存格:結束儲存格)

Sum(
傳回指定儲存格範圍中各數值的總和。

語法：Sum(開始儲存格:結束儲存格)

範例 3：接續範例 1，輸入公式 =Sum(A1:A3)，這會將儲存格 A1、A2 及
A3 的總和計算至儲存格 A4。
1.將游標移至儲存格 A4。
2.輸入 =Sum(A1:A3)。

(=)  – [Spreadsheet] > [Sum]
(A)

 – [Spreadsheet] > [:]
(A)

3.按  鍵。
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在多個儲存格中分批輸入相同公式或常數

您可使用本節中的程序，將相同公式或常數輸入至一系列特定的儲存格。使

用 Fill Formula 命令分批輸入公式，或使用 Fill Value 分批輸入常數。

注意

• 如果輸入的公式或常數包含相對參照，將根據指定範圍的左上儲存格輸入相對參照。如

果輸入的公式或常數包含絕對參照，絕對參照將被輸入至指定範圍的所有儲存格中。

若要將相同公式分批輸入至一系列儲存格

範例 4：接續範例 1，將數值為左邊儲存格兩倍再減去 3 的一個公式，分批

輸入至儲存格 B1、B2 及 B3。
1.將游標移至儲存格 B1。
2.按下 ，選擇 [Fill Formula]，然後按下 。

• 這會顯示 Fill Formula 畫面。

3.在「Form」行中，輸入公式 =2A1-3：2 (A) 3 。

• 不需要在開頭輸入等號（=）。

4.在「Range」行中，將 B1:B3 指定為批次輸入的範圍。

5.若要套用輸入，請按下 。

• 這會將 =2A1-3 輸入至儲存格 B1、將 =2A2-3 輸入至儲存格 B2，並將

=2A3-3 輸入至儲存格 B3。

若要將相同常數分批輸入至一系列儲存格

範例 5：接續範例 4，將數值為左邊儲存格數值三倍的值分批輸入至儲存格

C1、C2 及 C3。
1.將游標移至儲存格 C1。
2.按下 ，選擇 [Fill Value]，然後按下 。

• 這會顯示 Fill Value 畫面。
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3.在「Value」行中，輸入常數 B1×3： (B) 3 。

4.在「Range」行中，將 C1:C3 指定為批次輸入的範圍。

5.若要套用輸入，請按下 。

• 這會將每個計算結果的值輸入至儲存格 C1、C2 及 C3。

Spreadsheet 應用程式設定項目

TOOLS 選單包含下列設定項目。

「◆」表示初始預設值。

Auto Calc
指定是否要自動重新計算公式。

On◆：啟用自動重新計算。

Off：停用自動重新計算。

Show Cell
指定編輯方塊中的公式是否依原樣或其計算結果值顯示。

Formula◆：依原樣顯示公式。

Value：顯示公式的計算結果值。

Auto Calc 和 Recalculate
「Auto Calc」是 TOOLS 選單上的設定項目（請參閱「Spreadsheet 應用

程式設定項目」（第 87 頁））。

在 Spreadsheet 應用程式使用初始預設值（Auto Calc：On）的情況下，每

次編輯儲存格內容時，就會自動重新計算儲存格中的公式。根據試算表的內

容，自動重新計算可能要花較長時間才能完成。當 Auto Calc 停用（Off）
時，您必須視需要手動執行重新計算。

若要手動重新計算

按下 ，選擇 [Recalculate]，然後按下 。

注意

• 即使 Auto Calc 設定設為 On，在下列情況下您必須執行 [Recalculate]。
- 使用 SETTINGS 選單變更 Angle Unit 設定時
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- 當儲存格包含使用函數「f(」或「g(」及對應定義方程式（f(x) 或 g(x)）的公式並更新

時

- 當儲存格包含使用變數及對應變數的公式並且更新時

建立數字表格

您可使用 Table 應用程式根據針對函數 f(x) 和 g(x) 登錄的定義方程式建立數

字表格。

建立數字表格的一般程序

範例：若要為函數 f(x) = x2 + 1
2  和 g(x) = x2 - 1

2  產生數字表格，範圍為 -1

≤ x ≤ 1，增量間距值為 0.5

1.按下 ，選擇 Table 應用程式圖示，然後按下 。

• 這會顯示數字表格畫面。

• 如果沒有為 f(x) 和 g(x) 的其中之一或兩者登錄定義方程式，且游標選

擇位置的資料為空白，訊息將會顯示在畫面底部，表示未登錄定義方程

式。

2.配置設定以從兩個函數產生數字表格。

(1) 按下  並選擇 [Table Type] > [f(x)/g(x)]。
(2) 按下 。

• 如需設定的相關資訊，請參閱「根據 Table Type 的數字表格最大列

數」（第 89 頁）。

3.為 f(x) 登錄定義方程式。

 – [Define f(x)/g(x)] > [Define f(x)]
1 2

（按下  前的畫面）

4.為 g(x) 登錄定義方程式。

 – [Define f(x)/g(x)] > [Define g(x)]
1 2

（按下  前的畫面）

• 您也可使用  登錄定義方程式。如需詳細資訊，請參閱「定義方程式

登錄」（第 89 頁）。

5.配置數字表格範圍設定。
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 – [Table Range]
((-))1 1 0 5

6.按  鍵。

• 這會顯示數字表格畫面中的結果。

• 數字表格產生作業將會使 x 變數的內容變更。

注意

• 在數字表格畫面上，您可將儲存格中的值儲存至變數。例如，在顯示上方步驟 6 中的畫

面時，執行下列操作會將 -1 儲存至變數 A：  – [A=] > [Store]。如需變數的詳細資

訊，請參閱「變數（A、B、C、D、E、F、x、y、z）」（第 34 頁）。

根據 Table Type 的數字表格最大列數

您可配置數字表格畫面設定，同時顯示 f(x) 和 g(x) 欄或僅顯示其中之一。

若要設定，請使用在數字表格畫面顯示時，按下  – [Table Type] 時出現

的選單。

f(x)/g(x) ...同時顯示 f(x) 和 g(x) 欄（初始預設值）

f(x) ...僅顯示 f(x) 欄
g(x) ...僅顯示 g(x) 欄

已產生數字表格的最大列數取決於 Table Type 設定。「f(x)」或「g(x)」設

定最多支援 45 列，而「f(x)/g(x)」設定支援 30 列。

定義方程式登錄

有兩種方式可登錄 f(x) 和 g(x) 的定義方程式。

• 當 Table 應用程式數字表格畫面顯示時，按下  以登錄方程式

 – [Define f(x)/g(x)] > [Define f(x)]
 – [Define f(x)/g(x)] > [Define g(x)]

• 當 Table 應用程式數字表格畫面顯示時，或使用 Distribution、Equation
(Simul Equation / Polynomial)、Inequality、Base-N、Ratio 及 Math Box
以外的任何計算器應用程式時，按下  以登錄方程式
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 – [Define f(x)]
 – [Define g(x)]

不論使用上述兩個操作的任何一個登錄定義方程式，都會顯示相同的 f(x) 或
g(x) 方程式登錄畫面。

注意

• 如需使用  進行操作的相關資訊，請參閱「登錄及使用 f(x) 和 g(x) 的定義方程式」

（第 56 頁）。

編輯數字表格畫面資料

若要刪除一列

1.在數字表格畫面上，將游標移至您要刪除的列上。

2.按  鍵。

若要插入一列

1.在數字表格畫面上，將游標移至您要插入列下方的列上。

2.執行下列操作：  – [Edit] > [Insert Row]。

若要刪除所有數字表格畫面內容

在數字表格畫面上，執行下列操作：  – [Edit] > [Delete All]。

若要變更在 x 欄的儲存格中輸入的值

您可在目前反白顯示的 x 儲存格中變更數值。變更 x 值會使同一列中的 f(x)
和 g(x) 值隨之更新。

若要使用下列方式將數值輸入至反白顯示的 x 欄儲存格：{上方儲存
格的值} +/- {間距值}

如果目前反白顯示的 x 儲存格上方的 x 儲存格中存在數值，則按下  或
 會將其上方儲存格值加上間距值的值，自動輸入至反白顯示的儲存格

中。此外，按下  會自動輸入上方儲存格值，減去間距值的值。同一列中

的 f(x) 和 g(x) 值也會隨之更新。

f(x) 和 g(x) 更新時間

數字表格畫面上顯示的 f(x) 和 g(x) 值會在下列任何情況發生時更新。

• 在 Table Range 畫面上選擇 [Execute] 的情況下，按下  時。

• f(x) 和 g(x) 的定義方程式更新時（定義方程式為複合函數時除外）。

• 數值輸入至 x 欄時（包括在 x 欄中，按下 、 、 ）。
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但請注意，數值不會在執行下列操作後自動更新。

• 使用 SETTINGS 選單變更 Angle Unit 設定時。

• 在包含變數的定義方程式（範例：f(x) = 2x + A）已登錄的情況下，更新

定義方程式的變數時。

• 當複合函數的定義方程式（範例：g(x) = f(x) × 2 - x）已登錄且參照函數

的定義方程式（範例：g(x) = f(x) × 2 - x 的 f(x)）更新（登錄新的定義方

程式）時。

在這些情況下，請在數字表格畫面顯示時，執行  – [Recalculate] 以更新

數值。

資料保留

執行下列操作將會捨棄 Table 應用程式的部分資料並清除部分設定。

① 返回 HOME 畫面並啟動其他計算器應用程式。

② 按下 。

③ 使用 SETTINGS 選單變更 Input/Output 設定。

④ 使用 TOOLS 選單變更 Table Type 設定。

下表顯示會被捨棄的資料及保留的資料。

操作

資料、設定
① ② ③ ④

數字表格資料
（x、f(x)、g(x) 欄） 捨棄 捨棄 捨棄 捨棄

Table Range 設定 捨棄 保留 保留 保留

Table Type 設定 保留 保留 保留 --
f(x)、g(x) 定義方程式 保留 捨棄 捨棄 保留

方程式計算

Equation 應用程式包含下述三種函數。啟動應用程式後，可使用顯示的

Equation 選單，選擇您要的函數。

Simul Equation：帶有兩至四個未知數的聯立一次方程式

Polynomial：二次至四次的高次方程式

Solver：用於尋找輸入方程式中，包含之任何變數值的函數
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聯立一次方程式

此處以帶有三個未知數的聯立一次方程式為例，說明解聯立一次方程式的一

般程序。

範例 1：

1.按下 ，選擇 Equation 應用程式圖示，然後按下 。

• 這會顯示 Equation 選單。

2.選擇 [Simul Equation]，然後按下 。

• 這會顯示未知數數量選單。

3.選擇 [3 Unknowns]，然後按下 。

• 這會顯示係數編輯畫面。

4.使用係數編輯畫面輸入係數值。

1 ((-))1 1 2
1 1 ((-))1 0

((-))1 1 1 4

• 在顯示係數編輯畫面時按下 ，將清除所有係數，使之為零。

5.按  鍵。

• 此時將會顯示解的內容。

• 當顯示  指示符號時，每次按下 （或 ）都會顯示另一個解。

（或 ）
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（或 ）

• 在  指示符號顯示時按下  或 ，會重新顯示先前顯示的解。

• 在顯示最後一個解之後，按下  鍵會返回係數編輯畫面。在顯示了任

意一個解之後，如果您想要返回係數編輯畫面，請按下  鍵。

• 在顯示係數編輯畫面時按下 ，會返回未知數數量選單。

注意

• 當係數編輯畫面顯示時，可將目前反白顯示的值儲存至變數。此外，當解正在顯示時，

目前顯示的解可儲存至變數。如需變數的詳細資訊，請參閱「變數（A、B、C、D、

E、F、x、y、z）」（第 34 頁）。

二次至四次的高次方程式

當您使用 Equation 應用程式解高次方程式時，以下數值會根據方程式的次

數顯示。

• 二次方程式

在顯示 ax2+bx+c=0 的解後，會顯示 y=ax2+bx+c 的最小值（或最大值）

座標（x、y）。

• 三次方程式

在顯示 ax3+bx2+cx+d=0 的解後，僅在存在局部最小值或局部最大值時，

會顯示 y=ax3+bx2+cx+d 的局部最小值（或局部最大值）座標（x、y）。

如果不存在局部最小值或局部最大值，則在最後解顯示時按下 ，將會

顯示「No Local Max/Min」訊息。

• 四次方程式

ax4+bx3+cx2+dx+e=0 的解會顯示。

此處以二次方程式為例，說明解高次方程式的一般程序。

範例 2：x2 + 2x − 2 = 0
(Input/Output：MathI/MathO)
1.按下 ，選擇 Equation 應用程式圖示，然後按下 。

• 這會顯示 Equation 選單。

2.選擇 [Polynomial]，然後按下 。

• 這會顯示次數選單。
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3.選擇 [ax2+bx+c]，然後按下 。

• 這會顯示係數編輯畫面。

4.使用係數編輯畫面輸入係數值。

1 2 ((-))2

• 在顯示係數編輯畫面時按下 ，將清除所有係數，使之為零。

5.按  鍵。

• 此時將會顯示解的內容。

• 當顯示  指示符號時，每次按下 （或 ），都會顯示另一個計算

結果（解或座標）。

（或 ）

（顯示 y = x2 + 2x − 2 的最小值 x 座標。）

（或 ）

（顯示 y = x2 + 2x − 2 的最小值 y 座標。）

（或 ）

• 在  指示符號顯示時按下  或 ，會重新顯示先前顯示的計算結

果。
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• 在顯示了最後計算結果之後，按下  鍵會返回係數編輯畫面。在顯示

了任意一個計算結果之後，如果您想要返回係數編輯畫面，請按下 
鍵。

• 在顯示係數編輯畫面時按下 ，會返回次數選單。

注意

• 當係數編輯畫面顯示時，可將目前反白顯示的值儲存至變數。此外，當顯示計算結果

（解或座標）時，可將其儲存至變數。如需變數的詳細資訊，請參閱「變數（A、B、

C、D、E、F、x、y、z）」（第 34 頁）。

複數解顯示（Complex Roots）

高次方程式可能有複數解。當在 Equation 選單上選擇 Polynomial 時，可使

用下列操作啟用或停用複數解顯示。

 – [Complex Roots] > [On] 
啟用複數解顯示（初始預設值）。

 – [Complex Roots] > [Off] 
停用複數解顯示。輸入並執行僅具有一或多個複數解的方程式，將會顯

示「No Real Roots」訊息。

範例 3：2x2 + 3x + 4 = 0
（Input/Output：MathI/MathO，Complex Result：a+bi，Complex Roots：
On）
1.按下 ，選擇 Equation 應用程式圖示，然後按下 。

• 這會顯示 Equation 選單。

2.選擇 [Polynomial] > [ax2+bx+c]。
• 這會顯示係數編輯畫面。

3.使用係數編輯畫面輸入係數值。

2 3 4

4.按  鍵。
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• 此時將會顯示解的內容。

5.顯示其他解及座標值。

（或 ）

（或 ）

（或 ）

• 在顯示了最後計算結果之後，按下  鍵會返回係數編輯畫面。在顯示

了任意一個計算結果之後，如果您想要返回係數編輯畫面，請按下 
鍵。

將複數解轉換為直角或極座標

您可使用按下  時顯示的 FORMAT 選單，將複數解轉換為直角座標或極

座標格式。

範例 4：若要將範例 3（第 95 頁） 中顯示的複數解轉換為極座標格式，接

著再轉換為直角座標格式

1.執行範例 3（第 95 頁） 的步驟 1 至 4。

2.按下 ，選擇 [Polar Coord]，然後按下 。

• 這會將解轉換為極座標格式。

3.按下 ，選擇 [Rectangular Coord]，然後按下 。

• 這會將解轉換為直角座標格式。
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使用 Solver
Solver 使用牛頓近似法解方程式。Solver 支援輸入下列格式的方程式。

範例：y = x + 5，x = sin(A)，xy + C（視為 xy + C = 0）

範例 5：若要在 B = 4 時解出 x2 - B
2  = 0 的 x

(Input/Output：MathI/MathO)

注意

• 在解出 x2 - B
2

 = 0 的 x 之前，4 必須儲存至變數 B。這會在下列程序的步驟 3 完成。

1.按下 ，選擇 Equation 應用程式圖示，然後按下 。

• 這會顯示 Equation 選單。

2.選擇 [Solver]，然後按下 。

• 這會顯示 Solver 方程式輸入畫面。

3.在此將 4 儲存至變數 B。

4

• 此操作可在此程序的步驟 7 之前的任何過程中執行。

• 如需變數的詳細資訊，請參閱「變數（A、B、C、D、E、F、x、y、
z）」（第 34 頁）。

• 按下  返回 Solver 方程式輸入畫面。

4.輸入方程式。

(B) 2
(=)*0

* 您也可使用下列操作輸入 = 符號：  – [Equation] > [=]。
5.按下  登錄輸入方程式。

6.在顯示的 Solve Target 畫面上，確認已選擇 [x] 並按下 。

• 這會顯示含有 x 初始值的畫面。

7.輸入 1 作為 x 的初始值。
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1

8.確認已選擇 [Execute] 後，按下 解方程式。

(1) 求解

(2) 解法

(3) (左側) − (右側) 形成結果

• 解答永遠會以小數形式顯示。

• (左側) − (右側) 結果越接近零，解答的準確性較高。

9.接著，按下您要執行之操作的按鍵。

執行的操作： 按下本鍵：

返回步驟 6 中的畫面。 *

儲存輸入表示式並返回步驟 4 中的畫面。 或

* 您按下此鍵時的初始值，會變為上次用於計算的初始值。

重要!

• Solver 會執行預設的收斂次數。如果無法找到解，則會

顯示如一旁所示的確認畫面，詢問您是否繼續。在選擇

[Continue] 時按下  可繼續，或選擇 [Exit] 並按下

，以取消 Solver 操作。

• 根據您為求解變數（上述範例中的 x）輸入的初始值，Solver 可能無法求得解。如果發

生這種情形，請試著改變初始值，使其更接近解答。

• Solver 可能無法判斷正確的解，即使該解存在。

• Solver 使用牛頓法，所以即使有多個解，也只會傳回一個解。

• 由於受到牛頓法則的限制，使得難以求得如下列各方程式的解答：y=sinx，y=ex，y= 
√x。

不等式計算

您可使用 Inequality 應用程式解二次、三次或四次不等式。
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執行不等式計算的一般程序

範例 1：若要求解 x2 + 2x - 3 ≥ 0
1.按下 ，選擇 Inequality 應用程式圖示，然後按下 。

• 這會顯示次數選單。

2.選擇 [ax2+bx+c]，然後按下 。

3.在出現的選單上，選擇不等式符號類型和方向（>、<、≥、≤)。
• 此處我們想解 x2 + 2x - 3 ≥ 0，選擇 [ax2+bx+c≥0] 並按下 。

4.在出現的係數編輯畫面上，輸入係數值。

1 2 ((-))3

5.按  鍵。

• 此時將會顯示解的內容。

• 在顯示解之後，如果您想要返回係數編輯畫面，請按下 、  或 
鍵。

• 在顯示係數編輯畫面時，按下  會返回步驟 2 中的選單。

• 在顯示步驟 2 中的選單時，按下  會返回次數選單。

注意

• 當在 SETTINGS 選單上的 Input/Output 設定中選擇 MathI/MathO 以外的選項時，解法

會如以下畫面所示顯示。

• 不等式沒有任何解法（例如 x2 < 0）時，解法畫面會顯示「No Solution」。

• 不等式的解法全部是數字（例如 x2 ≥ 0）時，解法畫面會顯示「All Real Numbers」。
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複數計算

若要執行複數計算，請先啟動 Complex 應用程式。

按下 ，選擇 Complex 應用程式圖示，然後按下 。

輸入複數

您可以使用直角座標 (a+bi) 或極座標 (r∠θ) 來輸入複數。

範例 1：若要輸入 2+3i

2 3 (i)*

* 您也可使用下列操作輸入 i：  – [Complex] > [i]。

範例 2：若要輸入 5∠30

5  – [Complex] > [∠] 30

Complex 應用程式計算範例

執行範例操作前

• 對於本節中的範例，請使用 SETTINGS 選單選擇 MathI/MathO，作為

Input/Output 設定。配置其他設定，如各範例所示。

• SETTINGS 選單上的 Complex Result 設定，可決定所顯示的複數計算結

果。

• 如果您打算以極座標格式執行輸入並顯示計算結果，請先在 SETTINGS
選單上指定 Angle Unit，再開始進行計算。

• 計算結果的 θ 值會顯示於 -180° < θ ≤ 180° 的範圍內。

• 在選擇了 MathI/MathO 以外設定的同時顯示計算結果時，將會在個別的

行上顯示 a 和 bi（或 r 和 θ）。

範例 3：(1 + i)4 + (1 - i)2 = -4 - 2i
(Complex Result：a+bi)

1 (i) 4
1 (i)

注意

• 使用語法 (a+bi)n 將複數遞增至整數冪時，冪次值可在下列範圍內：-1 × 1010 < n < 1 ×
1010。

範例 4：2∠45 = √2 + √2i
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(Angle Unit：Degree、Complex Result：a+bi)

2  – [Complex] > [∠] 45

範例 5：√2 + √2i = 2∠45
(Angle Unit：Degree、Complex Result：r∠θ)

2 2 (i)

範例 6：若要求得 2 + 3i 的共軛複數

(Complex Result：a+bi)

 – [Complex] > [Conjugate]
2 3 (i)

範例 7：若要求得 1 + i 的絕對值和幅角

(Angle Unit：Degree)

 – [Numeric Calc] > [Absolute Value]
1 (i)

 – [Complex] > [Argument]
1 (i)

範例 8：若要擷取 2 + 3i 的實數部分和虛數部分

 – [Complex] > [Real Part]
2 3 (i)

 – [Complex] > [Imaginary Part]
2 3 (i)

將複數計算結果轉換為直角或極座標

您可使用按下  時顯示的 FORMAT 選單，將複數計算結果轉換為直角座

標或極座標格式。
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範例 9：√2 + √2i = 2∠45，2∠45 = √2 + √2i
(Angle Unit：Degree、Complex Result：a+bi)

2 2 (i)

 – [Polar Coord]

 – [Rectangular Coord]

基數計算

當您想使用十進位、十六進位、二進位和／或八進位值執行計算時，請啟動

Base-N 應用程式。按下 ，選擇 Base-N 應用程式圖示，然後按下 。

啟動 Base-N 應用程式時的初始預設數字模式為十進位。

啟動 Base-N 應用程式後，使用  切換數字模式。

每次按下  會如下所示，循環切換數字模式。

(1) [Decimal]  (2) [Hexadecimal]  (3) [Binary]  (4) [Octal]

注意

• 範例中附加到數值的下標表示各數值的基數（數字模式）。

範例：12 ...二進位 1；116 ...十六進位 1

範例 1：計算 112 + 12

1.使用  將數字模式變更為 [Binary]。
2.執行計算 112 + 12。

11 1
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範例 2：若要以十六進位計算 1F16 + 116

1.使用  將數字模式變更為 [Hexadecimal]。
2.執行計算 1F16 + 116。

1 (F) 1

注意

• 使用下列按鍵來輸入十六進位值的字母 A 到 F： (A)、 (B)、 (C)、
(D)、 (E)、 (F)。您也可使用下列顯示的 CATALOG 選單項目輸入

十六進位值。

 – [Hex Value] > [A]、[B]、[C]、[D]、[E] 或 [F]
• 請注意，如果使用下列操作輸入 A 至 F 的任何字元，則字元會被視為變數名稱，不會

被視為十六進位值。

(1) 按下  顯示變數清單畫面。

(2) 選擇 [A=]、[B=]、[C=]、[D=]、[E=] 或 [F=]，然後按下 。

(3) 在出現的選單中，選擇 [Recall]。
• 在 Base-N 應用程式中，不支援輸入分數（小數）值和指數。如果計算結果包含分數部

分，則會將該部份截斷。

• 以下詳細說明輸入和輸出的範圍（32 位元）。• 

基數 範圍

二進位

正數：00000000000000000000000000000000 ≤ x ≤
01111111111111111111111111111111
負數：10000000000000000000000000000000 ≤ x ≤
11111111111111111111111111111111

八進位
正數：00000000000 ≤ x ≤ 17777777777
負數：20000000000 ≤ x ≤ 37777777777

十進位 -2147483648 ≤ x ≤ 2147483647

十六進位
正數：00000000 ≤ x ≤ 7FFFFFFF
負數：80000000 ≤ x ≤ FFFFFFFF

• 當計算結果超出目前使用之數字系統的適用範圍之外時，會發生 Math ERROR。

指定特定輸入值的數字模式

您可以在某個值之前輸入特殊命令，以指定該值的數字模式。這些特殊指令

為：d (十進位)、h (十六進位)、b (二進位) 和 o (八進位)。

範例 3：若要計算 1010 + 1016 + 102 + 108 並將結果以十進位值顯示

1.使用  將數字模式變更為 [Decimal]。
2.執行計算 1010 + 1016 + 102 + 108。
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 – [Base Prefix] > [Decimal(d)] 10
 – [Base Prefix] > [Hexadecimal(h)] 10

 – [Base Prefix] > [Binary(b)] 10
 – [Base Prefix] > [Octal(o)] 10

將計算結果轉換為其他類型的值

您可以使用 ，將目前顯示的計算結果轉換為另一種類型的值。

範例 4：若要以十進位模式計算 1510 × 3710，然後再將結果轉換為十六進位

1.使用  將數字模式變更為 [Decimal]。
2.執行計算 1510 × 3710。

15 37

3.使用  將數字模式變更為 [Hexadecimal]。

邏輯和負數運算

按下  並選擇 [Logic Operation]，然後從顯示的選單選擇所需的命令

（Neg、Not、and、or、xor、xnor），可執行邏輯和負數運算。以下所有

範例都是在二進位模式下執行。

範例 5：若要求得 10102 和 11002 的邏輯 AND 結果 (10102 and 11002)

1010
 – [Logic Operation] > [and]

1100

範例 6：若要求得 10102 的位元補數運算結果 (Not(10102))

 – [Logic Operation] > [Not]
1010

注意

• 在二進位、八進位或十六進位的負數運算中，計算器會將值轉換為二進位，取得二的補

數，然後再將其轉換回原始的數字基數。對於十進位值，計算器只會增加一個減號。

104



矩陣計算

使用 Matrix 應用程式執行包含 4 列 × 4 行矩陣的計算。

執行矩陣計算的一般程序

若要執行矩陣計算，請使用特殊矩陣變數（MatA、MatB、MatC、

MatD），如下列範例所示。

範例 1：若要計算 

• 對於乘法（矩陣 1 × 矩陣 2），矩陣 1 的行數必須符合矩陣 2 的列數，否

則會發生錯誤。

1.按下 ，選擇 Matrix 應用程式圖示，然後按下 。

• 這會顯示矩陣計算畫面。

2.按  鍵。

• 這會顯示矩陣變數清單畫面。

• 如需矩陣變數清單畫面內容，以及如何執行矩陣變數儲存、編輯或其他

操作的詳細資訊，請參閱「矩陣變數清單畫面」（第 106 頁）。

3.執行下列步驟，將  儲存至 MatA。

(1) 選擇 [MatA:]，然後按下 。

• 這會顯示矩陣大小設定畫面（初始預設值：2 列、2 行）。

(2) 此處我們想儲存 2×2 矩陣，因此選擇 [Confirm] 並按下 。

• 這會顯示矩陣編輯畫面，讓您輸入 MatA 的 2×2 矩陣元素。

(3) 輸入 MatA 的元素。
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2 1 1 1

(4) 按下 、  或  返回矩陣計算畫面。

4.執行下列步驟，將  儲存至 MatB。

(1) 按下 ，選擇 [MatB:]，然後按下 。

(2) 選擇 [Confirm]，然後按下 。

(3) 輸入 MatB 的元素。

2 ((-))1 ((-))1 2

(4) 按下 、  或  返回矩陣計算畫面。

5.輸入 MatA×MatB。

 – [Matrix] > [MatA]
 – [Matrix] > [MatB]

6.按  鍵。

• 這會顯示含有計算結果的 MatAns（矩陣答案儲存器）畫面。

• 如需 MatAns 的詳細資訊，請參閱「矩陣答案儲存器（MatAns）」

（第 109 頁）。

• 在顯示 MatAns 畫面時，按下  會返回矩陣計算畫面，並清除計算表

示式。按下  或  返回此程序的步驟 5 中的計算表示式輸入完成狀

態。

注意

• 當矩陣編輯畫面或 MatAns 畫面顯示時，可將目前反白顯示的值儲存至變數。當矩陣計

算畫面顯示且計算結果值出現在畫面上時，可將顯示的計算結果儲存至變數。如需變數

的詳細資訊，請參閱「變數（A、B、C、D、E、F、x、y、z）」（第 34 頁）。

矩陣變數清單畫面

當您想將矩陣儲存至矩陣變數 MatA、MatB、MatC 或 MatD 或編輯先前儲

存的矩陣時，應使用矩陣變數清單畫面。各矩陣變數的狀態如下列範例所

示。
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(1) 2×2
表示 2×2 矩陣已儲存至矩陣變數。

(2) None
表示未將任何資料儲存至矩陣變數。

顯示矩陣變數清單畫面

根據目前顯示的畫面，執行下列任一操作。

• 顯示矩陣計算畫面時：

按下 。

• 顯示矩陣編輯畫面或 MatAns 畫面時：

按下 ，選擇 [Define Matrix]，然後按下 。

將新資料儲存至矩陣變數

範例 2：若要儲存 2×3 矩陣 

1.當顯示矩陣計算畫面時，按下  顯示矩陣變數清單畫面。

2.選擇您要儲存新資料的矩陣變數（MatA、MatB、MatC 或 MatD），然後

按下 。

• 如果選擇狀態為「None」的矩陣變數，請繼續此程序的步驟 4。
• 如果選擇已儲存矩陣的矩陣變數，將會顯示選單畫面。繼續步驟 3。

3.選擇 [Define New]，然後按下 。

4.在顯示的「Matrix Size?」畫面上，指定矩陣的列數及行數。

• 若要指定 2×3 矩陣，請執行下列步驟。

(1) 選擇 [Rows]，然後按下 。在顯示的選單上，選擇 [2 Rows] 並按下

。

(2) 選擇 [Columns]，然後按下 。在顯示的選單上，選擇 [3 Columns]
並按下 。

5.確認所需的列和行規格後，選擇 [Confirm] 並按下 。

• 這會顯示矩陣編輯畫面。
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6.輸入矩陣變數的元素。

1 0 ((-))1
0 ((-))1 1

7.按下 、  或  返回矩陣計算畫面。

注意

• 即使您按下 、變更計算器應用程式或關閉計算器，矩陣變數內容都會保留。執行下

列任一操作會清除所有矩陣變數的內容。

-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All]

編輯矩陣變數資料

1.當顯示矩陣計算畫面時，按下  顯示矩陣變數清單畫面。

2.選擇您要編輯的矩陣變數（MatA、MatB、MatC 或 MatD），然後按下

。

3.在顯示的選單上，選擇 [Edit] 並按下 。

• 這會顯示矩陣編輯畫面。

4.使用矩陣編輯畫面編輯矩陣的元素。

• 將游標移到包含您想要變更其元素的方格中，輸入新的值，然後按下

。

5.按下 、  或  返回矩陣計算畫面。

複製矩陣變數（或 MatAns）的內容

1.顯示您要用作複製來源之矩陣變數的矩陣編輯畫面或 MatAns 畫面。

• 若要顯示矩陣編輯畫面，請執行「編輯矩陣變數資料」（第 108 頁）

下的步驟 1、2 及 3。
• 若要顯示 MatAns 畫面，請在顯示矩陣計算畫面時執行下列步驟。

 – [Matrix] > [MatAns] 
2.選擇矩陣變數複製目的地。

• 例如，若要複製到 MatD，請執行下列操作：  – [Store] > [MatD]。
• 這會顯示矩陣編輯畫面，其中內含複製目的地的內容。

3.按下 、  或  返回矩陣計算畫面。
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矩陣答案儲存器（MatAns）
只要在 Matrix 應用程式中執行的計算結果為矩陣，則 MatAns 畫面將會顯

示結果。該結果同時也會儲存至名為「MatAns」的變數。

MatAns 變數可以在計算中使用，如下所示。

• 若要將 MatAns 變數插入計算中，請執行下列操作：  – [Matrix] >
[MatAns]。

• 在 MatAns 畫面顯示的同時按下列任何一個按鍵，將會自動切換至顯示

「MatAns」變數的矩陣計算畫面，其後接著您所按下按鍵的運算子或函

數： 、 、 、 、 、 、 、 ( )、 ( )。

注意

• 即使您按下  或關閉計算器，MatAns 內容都會保留。執行下列任一操作會清除

MatAns 內容。

- 返回 HOME 畫面並啟動其他計算器應用程式

- 執行  – [Reset] > [Settings & Data]
- 執行  – [Reset] > [Initialize All]

矩陣計算範例

下列範例使用 MatA = 、MatB = 、MatC = 、MatD

= 。

範例 3：若要將兩個矩陣相加（MatA + MatB）

 – [Matrix] > [MatA]
  – [Matrix] > [MatB] 

注意

• 兩個矩陣必須具有相同的維度，才能相加或相減。如果嘗試加上或減去不同維度的矩

陣，則會發生錯誤。

範例 4：若要求得 MatA 的平方和立方（MatA2、MatA3）

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Matrix Squared]

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Matrix Cubed]
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範例 5：若要求得 MatA 的反矩陣（MatA-1）

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Inverse Matrix]

注意

• 只有方陣（具有相同的列數及行數）能求反矩陣。嘗試對不是正方形的矩陣求反矩陣會

發生錯誤。

• 無法對行列式值為零的矩陣求反矩陣。嘗試對行列式值為零的矩陣求反矩陣會發生錯

誤。

• 對於行列式值接近零的矩陣，計算精確度會受影響。

範例 6：若要求得 MatA 的行列式值（Det(MatA)）

 – [Matrix] > [Matrix Calc] >
[Determinant]  – [Matrix] > [MatA]
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注意

• 僅能求得方陣（具有相同的列數及行數）的行列式值。嘗試對不是正方形的矩陣求行列

式值會發生錯誤。

範例 7：若要求得 MatC 的轉置（Trn(MatC)）

 – [Matrix] > [Matrix Calc] >
[Transposition]  – [Matrix] > [MatC]

範例 8：若要建立一個 2 × 2 單位矩陣，並將其加到 MatA (Identity(2) +
MatA)

 – [Matrix] > [Matrix Calc] > [Identity]
2   – [Matrix] > [MatA]

注意

• 您可指定 1 至 4 之間的值作為 Identity 命令引數（維度數目）。

範例 9：若要求得 MatC 每個元素的絕對值（Abs(MatC)）

 – [Numeric Calc] > [Absolute Value]
 – [Matrix] > [MatC]

向量計算

使用 Vector 應用程式執行二維和三維向量計算。

執行向量計算的一般程序

若要執行向量計算，請使用特殊向量變數（VctA、VctB、VctC、VctD），

如下列範例所示。

範例 1：若要計算 (1, 2) + (3, 4)
• 執行兩個向量的加減運算時，兩者必須具有相同維度。

1.按下 ，選擇 Vector 應用程式圖示，然後按下 。

• 這會顯示向量計算畫面。
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2.按  鍵。

• 這會顯示向量變數清單畫面。

• 如需向量變數清單畫面內容以及如何執行向量變數儲存、編輯或其他操

作的詳細資訊，請參閱「向量變數清單畫面」（第 113 頁）。

3.執行下列步驟，將 (1, 2) 儲存至 VctA。
(1) 選擇 [VctA:]，然後按下 。

• 這會顯示向量維度設定畫面（初始預設值：2 維）。

(2) 此處我們想儲存一個二維向量，因此選擇 [Confirm] 並按下 。

• 這會顯示向量編輯畫面，讓您輸入 VctA 的二維向量。

(3) 輸入 VctA 的元素。

1 2

(4) 按下 、  或  返回向量計算畫面。

4.執行下列步驟，將 (3, 4) 儲存至 VctB。
(1) 按下 ，選擇 [VctB:]，然後按下 。

(2) 選擇 [Confirm]，然後按下 。

(3) 輸入 VctB 的元素。

3 4

(4) 按下 、  或  返回向量計算畫面。

5.輸入 VctA+VctB。
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 – [Vector] > [VctA]
 – [Vector] > [VctB]

6.按  鍵。

• 這會顯示含有計算結果的 VctAns（向量答案儲存器）畫面。

• 如需 VctAns 的詳細資訊，請參閱「向量答案儲存器（VctAns）」

（第 115 頁）。

• 在顯示 VctAns 畫面時，按下  會返回向量計算畫面，並清除計算表

示式。按下  或  返回此程序的步驟 5 中的計算表示式輸入完成狀

態。

注意

• 當向量編輯畫面或 VctAns 畫面顯示時，可將目前反白顯示的值儲存至變數。當向量計

算畫面顯示且計算結果值出現在畫面上時，可將顯示的計算結果儲存至變數。如需變數

的詳細資訊，請參閱「變數（A、B、C、D、E、F、x、y、z）」（第 34 頁）。

向量變數清單畫面

當您想將向量儲存至向量變數 VctA、VctB、VctC 或 VctD 或編輯先前儲存

的向量時，應使用向量變數清單畫面。各向量變數的狀態如下列範例所示。

(1) 2
表示一個二維向量已儲存至向量變數。

(2) None
表示未將任何資料儲存至向量變數。

顯示向量變數清單畫面

根據目前顯示的畫面，執行下列任一操作。

• 顯示向量計算畫面時：

按下 。

• 顯示向量編輯畫面或 VctAns 畫面時：

按下 ，選擇 [Define Vector]，然後按下 。
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將新資料儲存至向量變數

範例 2：若要儲存三維向量 (1, 2, 3)
1.當顯示向量計算畫面時，按下  顯示向量變數清單畫面。

2.選擇您要儲存新資料的向量變數（VctA、VctB、VctC 或 VctD），然後按

下 。

• 如果選擇狀態為「None」的向量變數，請繼續此程序的步驟 4。
• 如果選擇已儲存向量的向量變數，將會顯示選單畫面。繼續步驟 3。

3.選擇 [Define New]，然後按下 。

4.在顯示的「Vector Dimension?」畫面上，指定向量維度。

• 若要指定三個維度，請執行下列步驟。

(1) 選擇 [Dimensions]，然後按下 。

(2) 在顯示的選單上，選擇 [3 Dimensions] 並按下 。

5.確認所需的維度規格後，選擇 [Confirm] 並按下 。

• 這會顯示向量編輯畫面。

6.輸入向量變數的元素。

1 2 3

7.按下 、  或  返回向量計算畫面。

注意

• 即使您按下 、變更計算器應用程式或關閉計算器，向量變數內容都會保留。執行下

列任一操作會清除所有向量變數的內容。

-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All]
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編輯向量變數資料

1.當顯示向量計算畫面時，按下  顯示向量變數清單畫面。

2.選擇您要編輯的向量變數（VctA、VctB、VctC 或 VctD），然後按下

。

3.在顯示的選單上，選擇 [Edit] 並按下 。

• 這會顯示向量編輯畫面。

4.使用向量編輯畫面編輯向量的元素。

• 將游標移到包含您想要變更其元素的方格中，輸入新的值，然後按下

。

5.按下 、  或  返回向量計算畫面。

複製向量變數（或 VctAns）的內容

1.顯示您要用作複製來源之向量變數的向量編輯畫面或 VctAns 畫面。

• 若要顯示向量編輯畫面，請執行「編輯向量變數資料」（第 115 頁）

下的步驟 1、2 及 3。
• 若要顯示 VctAns 畫面，請在顯示向量計算畫面時，執行下列步驟。

 – [Vector] > [VctAns] 
2.選擇向量變數複製目的地。

• 例如，若要複製到 VctD，請執行下列操作：  – [Store] > [VctD]。
• 這會顯示向量編輯畫面，其中內含複製目的地的內容。

3.按下 、  或  返回向量計算畫面。

向量答案儲存器（VctAns）
每當在 Vector 應用程式中執行的計算結果是向量時，VctAns 畫面將出現結

果。該結果同時也會儲存至名為「VctAns」的變數。

VctAns 變數可以在計算中使用，如下所示。

• 若要將 VctAns 變數插入計算中，請執行下列操作：  – [Vector] >
[VctAns]。

• 在 VctAns 畫面顯示的同時，按下列任何一個按鍵，將會自動切換至顯示

「VctAns」變數的向量計算畫面，其後接著您所按下按鍵的運算子或函

數： 、 、 、 、 、 、 、 ( )、 ( )。

注意

• 即使您按下  或關閉計算器，VctAns 內容都會保留。執行下列任一操作會清除

VctAns 內容。

- 返回 HOME 畫面並啟動其他計算器應用程式

- 執行  – [Reset] > [Settings & Data]
- 執行  – [Reset] > [Initialize All]
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向量計算範例

以下範例使用 VctA = (1, 2)、VctB = (3, 4) 及 VctC = (2, -1, 2)。

範例 3：VctA • VctB（向量內積）

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Dot Product]

 – [Vector] > [VctB]

注意

• 計算內積時，兩個向量的維度必須相同。

範例 4：VctA × VctB（向量外積）

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Cross Product]

 – [Vector] > [VctB]

注意

• 計算外積時，兩個向量的維度必須相同。

範例 5：若要確定由 VctA 和 VctB 所形成的角度有三位小數。(Number
Format：Fix 3、Angle Unit：Degree)

 – [Vector] > [Vector Calc] > [Angle]
 – [Vector] > [VctA]

(,)  – [Vector] > [VctB]

注意

• 計算由兩個向量所形成的角度時，兩個向量的維度必須相同。

範例 6：若要標準化 VctB

 – [Vector] > [Vector Calc] > [Unit Vector]
 – [Vector] > [VctB]
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範例 7：若要取得 VctC 的絕對值

 – [Numeric Calc] > [Absolute Value]
 – [Vector] > [VctC]

比例計算

已知 A、B、C 和 D 的值時，Ratio 應用程式可讓您決定比例表示式 A : B =
X : D（或 A : B = C : X）中的 X 值。

執行比例計算的一般程序

範例 1：若要解 3 : 8 = X : 12 的 X
1.按下 ，選擇 Ratio 應用程式圖示，然後按下 。

2.在出現的選單上，選擇 [A:B=X:D] 或 [A:B=C:X]。
• 此處我們想解 3 : 8 = X : 12 的 X，選擇 [A:B=X:D] 並按下 。

3.在出現的係數編輯畫面上，輸入係數值。

• 在此輸入下列係數：A = 3、B = 8、D = 12。

3 8 12

4.在輸入了您想要輸入的所有數值之後，請按下  鍵。

• 這會顯示解法（X 的值）。

• 按下 、  或  返回係數編輯畫面。

注意

• 如果在對於係數輸入 0 時進行計算，將發生 Math ERROR。

• 執行下列步驟可將係數編輯畫面的所有係數重設為 1。
- 當顯示係數編輯畫面時，按下 、 、  或 。

- 當顯示解時，按下  或 。

• 您可將目前顯示的計算結果儲存至變數。例如，在顯示上方步驟 4 中的畫面時，執行下

列操作會將計算結果儲存至變數 A：  – [A=] > [Store]。如需變數的詳細資訊，請參

閱「變數（A、B、C、D、E、F、x、y、z）」（第 34 頁）。
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若要變更比例表示式類型

1.當顯示係數編輯畫面時，按下 。

2.在出現的選單上，選擇您要的比例表示式類型。

計算範例

範例 2：按照比例 1 : 2 = X : 10 計算 X

 – [Ratio] > [A:B=X:D]
1 2 10

使用 Math Box
Math Box 應用程式具有下列學習支援之功能。

Dice Roll：Dice Roll 功能可模擬擲骰子並得到次數或頻率表 。
Coin Toss：Coin Toss 功能可模擬擲硬幣並得到次數或頻率表 。

Dice Roll
Dice Roll 會執行一個、兩個或三個虛擬骰子，丟擲指定次數的模擬。您可

選擇下列任一畫面查看結果。

List 畫面

Relative Freq 畫面

Dice Roll 一般操作程序

範例：若要模擬丟擲兩個骰子 100 次。在此範例中，Relative Freq 畫面用

於呈現模擬結果，其中顯示每次丟擲兩個骰子之間的差值（0、1、2、3、
4、5）的出現次數（頻率）及相對頻率。
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1.按下 ，選擇 Math Box 應用程式圖示，然後按下 。

• 這會顯示 Math Box 選單。

2.選擇 [Dice Roll]，然後按下 。

• 這會顯示參數輸入畫面。

Dice：選擇骰子數量為 1、2 或 3。
Attempts：輸入骰子丟擲次數（試驗次數）的值，範圍介於 1 至 250。
Same Result：此設定通常為 Off（初始預設值）。如需詳細資訊，請參

閱「Same Result 設定」（第 121 頁）。

3.選擇每個選單設定並視需要配置。

(1) 選擇 [Dice]，然後按下 。在顯示的選單上，選擇 [2 Dice] 並按下

。

(2) 選擇 [Attempts]，然後按下 。在顯示的輸入畫面上，輸入 100 並按

下 。選擇 [Confirm]，然後按下 。

(3) 將 [Same Result] 保持設為 Off（初始預設值）。

4.確認所需的所有設定後，選擇 [Execute] 並按下 。

• 顯示模擬執行的畫面將會出現，接著畫面將會變為 Result Type 選單。

List：顯示每次丟擲（試驗）結果的清單。*1

Relative Freq：根據丟擲結果*2 顯示出現次數及其相對頻率。

*1 當選擇兩個骰子時，每次丟擲的結果會隨每次丟擲的總和與差值一起顯

示。當選擇三個骰子時，每次丟擲的結果會隨丟擲的總和一起顯示。

*2 一個骰子的結果（1 至 6）、兩個骰子的結果總和（2 至 12）或差值

（0 至 5），以及三個骰子的結果總和（3 至 18）。

5.使用 Result Type 選單選擇結果顯示格式。

(1) 此處我們想顯示出現次數及相對頻率，因此選擇 [Relative Freq] 並按

下 。

• 這會顯示 [Sum] 或 [Difference] 選擇選單。

(2) 此處我們想顯示每次丟擲結果的差值，因此選擇 [Difference] 並按下

。

• 模擬結果會顯示在 Relative Freq 畫面上。
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（每次進行會有不同的結果。）

• 如需模擬結果畫面的詳細資訊，請參閱「Dice Roll 結果畫面」

（第 120 頁）。

6.若要以不同格式顯示結果，請顯示結果畫面並按下 。

• 這會返回 Result Type 選單，您可重新執行此程序的步驟 5，並變更結

果顯示格式。

7.如果要使用不同的設定執行模擬，請在顯示 Result Type 選單時按下

。

• 這會清除模擬結果並回到參數輸入畫面。從步驟 3 重新執行程序。

8.若要退出 Dice Roll，請在顯示參數輸入畫面時按下 。

• 這會返回 Math Box 選單。

注意

• 在 Relative Freq 畫面上，您可將 Rel Fr 欄儲存格中的值儲存至變數。例如，執行上述

步驟 5 中的下列操作，會將「Rel Fr」欄第一列中的值儲存至變數 A：  – [A=] >
[Store]。如需變數的詳細資訊，請參閱「變數（A、B、C、D、E、F、x、y、z）」

（第 34 頁）。

Dice Roll 結果畫面

• List 畫面

(1) 每列顯示一個連續丟擲編號。例如，1 代表第一次丟擲，2 代表第二

次丟擲，以此類推。

(2) A、B 及 C 代表個別骰子。「Sum」表示結果總和，「Diff」表示兩個

骰子結果的差值。顯示幕上顯示的欄數取決於使用的骰子數量。

1 個骰子：僅 A 欄。

2 個骰子：A、B、Sum 及 Diff 欄。

3 個骰子：A、B、C 及 Sum 欄。

• Relative Freq 畫面
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(1) Sum 或 Diff：顯示一個骰子結果（Sum：1 至 6）、兩個骰子結果總

和（Sum：2 至 12）或差值（Diff：0 至 5），或三個骰子結果總和

（Sum：3 至 18）。

(2) Freq：顯示每次丟擲結果的出現次數（頻率）。

(3) Rel Fr：顯示丟擲結果的相對頻率（頻率除以丟擲次數）。

(4) 試驗次數

(5) 反白顯示的 Rel Fr 儲存格的數值

Same Result 設定

使用 Same Result 的初始預設值（Off）執行 Dice Roll 或 Coin Toss 模擬

時，每次執行會顯示一個不同（隨機）結果。如果 Same Result 設定變更

為 Off 以外的其他選項，則顯示結果為計算器求得的資料。當您想讓課堂上

的學生使用的所有計算器都顯示相同的結果時，使用 #1、#2 或 #3 設定會

有所幫助。

注意

• 若要讓多台計算器顯示相同的結果，請確定所有計算器的下列設定皆相同。

- 骰子或硬幣數量

- 試驗次數（骰子或硬幣的丟擲次數）

- Same Result 設定（#1、#2 或 #3）

Coin Toss
Coin Toss 會執行一個、兩個或三個虛擬硬幣丟擲指定次數的模擬。您可選

擇下列任一畫面查看結果。

List 畫面
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Relative Freq 畫面

畫面顯示正面為 ，反面為 。

Coin Toss 一般操作程序

範例：若要模擬丟擲三個硬幣 100 次。在此範例中，Relative Freq 畫面用

於呈現模擬結果，其中顯示每次丟擲的正面數量（0、1、2、3）及相對頻

率。

1.按下 ，選擇 Math Box 應用程式圖示，然後按下 。

• 這會顯示 Math Box 選單。

2.選擇 [Coin Toss]，然後按下 。

• 這會顯示參數輸入畫面。

Coins：選擇硬幣數量為 1、2 或 3。
Attempts：輸入硬幣丟擲次數（試驗次數）的值，範圍介於 1 至 250。
Same Result：此設定通常為 Off（初始預設值）。如需詳細資訊，請參

閱「Same Result 設定」（第 121 頁）。

3.選擇每個選單設定並視需要配置。

(1) 選擇 [Coins]，然後按下 。在顯示的選單上，選擇 [3 Coins] 並按下

。

(2) 選擇 [Attempts]，然後按下 。當顯示輸入畫面時，輸入 100 並按下

。選擇 [Confirm]，然後按下 。

(3) 將 [Same Result] 保持設為 Off（初始預設值）。

4.確認所需的所有設定後，選擇 [Execute] 並按下 。

• 顯示模擬執行的畫面將會出現，接著畫面將會變為 Result Type 選單。
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List：顯示每次丟擲（試驗）的正面或反面*1 清單。

Relative Freq：顯示每個硬幣出現正面的次數*2 及其相對頻率。

*1 當選擇兩個或三個硬幣時，顯示每次丟擲時正面朝上的硬幣數量。

*2 適用於兩或三個硬幣。當選擇一個硬幣時，這會顯示正反面的頻率及相

對頻率。

5.使用 Result Type 選單選擇結果顯示格式。

此處我們想顯示出現次數及相對頻率，因此選擇 [Relative Freq] 並按下

。

• 模擬結果會顯示在 Relative Freq 畫面上。

（每次進行會有不同的結果。）

• 如需模擬結果畫面的詳細資訊，請參閱「Coin Toss 結果畫面」（第

123 頁）。

6.若要以不同格式顯示結果，請顯示結果畫面並按下 。

• 這會返回 Result Type 選單，您可重新執行此程序的步驟 5，並變更結

果顯示格式。

7.如果要使用不同的設定執行模擬，請在顯示 Result Type 選單時按下

。

• 這會清除模擬結果並回到參數輸入畫面。從步驟 3 重新執行程序。

8.若要退出 Coin Toss，請在顯示參數輸入畫面時按下 。

• 這會返回 Math Box 選單。

注意

• 在 Relative Freq 畫面上，您可將 Rel Fr 欄儲存格中的值儲存至變數。例如，執行上述

步驟 5 中的下列操作，會將「Rel Fr」欄第一列中的值儲存至變數 A：  – [A=] >
[Store]。

Coin Toss 結果畫面

• List 畫面
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(1) 每列顯示一個連續丟擲編號。例如，1 代表第一次丟擲，2 代表第二

次丟擲，以此類推。

(2) A、B 及 C 代表個別硬幣。當使用兩個或三個硬幣時，右側的  欄
會顯示正面朝上的硬幣數量。

• Relative Freq 畫面

(1) Side：僅使用一個硬幣時，「 」代表正面，「 」代表反面。當使

用兩或三個硬幣時，此欄顯示正面數量（0 至 3）。

(2) Freq：顯示每次丟擲結果的出現次數（頻率）。

(3) Rel Fr：顯示丟擲結果的相對頻率（頻率除以丟擲次數）。

(4) 試驗次數

(5) 反白顯示的 Rel Fr 儲存格的數值
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技術資訊

錯誤

在計算過程中，無論因為什麼原因而發生錯誤，計算器都會顯示錯誤訊息。

顯示錯誤位置

當顯示錯誤訊息時，按下 、  或  可返回錯誤訊息出現前顯示的畫

面。游標將定位在發生錯誤的位置，以供您進行輸入。對計算做出必要的修

改，然後再次執行。

範例：在您錯誤輸入 14 ÷ 0 × 2 而不是 14 ÷ 10 × 2。

14 0 2

（或  或 ）

1

錯誤訊息

Syntax ERROR

原因：

• 您正在執行的計算有格式問題。

處理：

• 進行必要的修改。

Math ERROR

原因：

• 您正在執行計算的中間或最後結果超出了可允許計算範圍。

• 您的輸入超過了可允許輸入範圍 (尤其是在使用函數時)。
• 您正在執行的計算包含非法數學操作 (例如除數為 0)。
• 當使用不支援複數的應用程式時，或顯示不接受複數輸入的畫面時，您

嘗試執行含有已儲存複數之變數的計算。
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處理：

• 檢查輸入的值，減少數字位數，然後重試。

• 在使用變數作為函數的引數時，請確保變數值在函數的允許範圍之內。

• 當使用不支援複數的應用程式時，或顯示不接受複數輸入的畫面時，若

要執行含有已儲存複數之變數的計算，請將儲存至變數的值變更為實

數。

Stack ERROR

原因：

• 您正在執行的計算會導致數字堆疊或命令堆疊超出容量範圍。

• 您正在執行的計算會導致矩陣堆疊或向量堆疊超出容量範圍。

處理：

• 簡化計算表示式，從而保證其不會超過堆疊容量。

• 將計算式分成兩個或更多部分。

Argument ERROR

原因：

• 您正在執行的計算有引數的問題。

處理：

• 進行必要的修改。

Dimension ERROR（僅限 Matrix 和 Vector 應用程式）

原因：

• 您目前嘗試執行的矩陣或向量計算，其維度不允許進行該類型的計算。

處理：

• 檢查為矩陣或向量所指定的維度，查看其是否與計算相容。

Variable ERROR（僅限 Equation 應用程式的 Solver 功能）

原因：

• 嘗試對不含任何變數的表示式，輸入執行 Solver。
處理：

• 輸入含有變數的表示式。

Cannot Solve（僅限 Equation 應用程式的 Solver 功能）

原因：

• 計算器無法取得解。
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處理：

• 檢查所輸入的方程式中是否有錯誤。

• 為求解變數輸入一個接近預期解的數值，然後再試一次。

Range ERROR

原因（Table 應用程式）：

• 嘗試在 Table 應用程式中，產生導致超過允許列數上限的數字表格。

處理：

• 藉由變更 Start、End 和 Step 數值縮小表計算範圍，然後再試一次。

原因（Spreadsheet 應用程式）：

• 在 Spreadsheet 應用程式中執行批次輸入期間，Range 的輸入超出允

許範圍或為不存在的儲存格名稱。

處理：

• 對於 Range，使用語法「A1:A1」在 A1 至 E45 的範圍內輸入儲存格名

稱。

原因（Math Box 應用程式）：

• Dice Roll 或 Coin Toss 的 Attempts（試驗次數）輸入值超出允許範圍

或為非整數值。

處理：

• 對於 Attempts，在允許範圍內輸入整數值。

Time Out

原因（微分或積分計算）：

• 目前的微分或積分計算已終止，但並未滿足終止條件。

處理：

• 嘗試增加 tol 值。請注意，如此做也會降低解答的精確度。

原因（Distribution 應用程式）：

• 目前的分配計算已終止，但並未滿足終止條件。

處理：

• 變更各參數的值。

Circular ERROR

原因（f(x) 和 g(x) 功能）：

• 已登錄的複合函數 （「登錄複合函數」（第 57 頁））發生循環參照。

處理：

• 不要同時將 g(x) 輸入至 f(x)，並將 f(x) 輸入至 g(x)。
原因（Spreadsheet 應用程式）：

• 試算表中存在循環參照（例如儲存格 A1 中輸入「=A1」）。

處理：

• 變更儲存格內容以移除循環參照。

127



Memory ERROR（僅限 Spreadsheet 應用程式）

原因：

• 您嘗試輸入超過允許輸入容量（1,700 位元組）的資料。

• 您嘗試輸入導致連續儲存格參照的資料（例如儲存格 A2 從儲存格 A1
參照、儲存格 A3 從儲存格 A2 參照等）。即使未超過記憶體容量

（1,700 位元組），這種輸入永遠會導致產生此類錯誤。

處理：

• 刪除不需要的資料並重新輸入資料。

• 將導致連續儲存格參照的輸入減到最少。

Not Defined

原因（f(x) 和 g(x) 功能）：

• 您嘗試在未定義 f(x)/g(x) 的情況下，計算 f(x) 或 g(x)。
處理：

• 先定義 f(x) 或 g(x)，再計算 f(x)/g(x)。
原因（Matrix 和 Vector 應用程式）：

• 您目前嘗試在計算中使用的矩陣或向量已輸入，但尚未指定其維度。

處理：

• 指定矩陣或向量的維度，然後再執行一次計算。

在確定計算器不正常之前...
請注意，您應該在執行這些步驟之前，對重要資料進行單獨的備份。

1.檢查計算表示式，以確保它不包含任何錯誤。

2.確保您在試圖執行此類計算時，使用正確的計算器應用程式。

• 若要查看目前使用的計算器應用程式，請按下 。這會標示目前使用

計算器應用程式的圖示。

3.如果上述步驟無法解決問題，請按下  鍵。

• 這會使得計算器執行檢查程序，檢查計算功能是否運行正常。如果計算

器發現了任何故障，那麼它會自動初始化計算器應用程式，並清除所有

記憶體內容。

4.執行下列程序，將計算器設定（不包括 Contrast 和 Auto Power Off），

恢復為初始預設值。

(1) 按下 ，選擇計算器應用程式圖示，然後按下 。

(2) 按下 ，然後選擇 [Reset] > [Settings & Data] > [Yes]。

更換電池

如果開啟電源後出現以下畫面，表示剩餘電池電力不足。
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當電池的電力過低時，螢幕也會變暗，即使是調整了對比度也沒有效果，或

者在您開啟計算器之後，螢幕上會立刻顯示錯誤圖示。

如果發生這種情況或顯示上方畫面，請立刻更換新電池。

重要!

• 移除電池會導致計算器記憶體中的所有內容被清除。

1.按下 (OFF) 關閉計算器。

• 為了確保在更換電池時不會意外開啟電源，請將前蓋裝到計算器正面。

2.如圖所示，拆下電池蓋、取出電池，然後裝入新電池，確定朝向正確的正

極（+）和負極（−）。

3.裝回電池蓋。

4.按下  打開計算器。

5.初始化計算器。

(1) 按下 ，選擇計算器應用程式圖示，然後按下 。

(2) 按下 ，然後選擇 [Reset] > [Initialize All] > [Yes]。
• 請勿跳過上述步驟！

計算式優先順序

計算器會根據計算優先順序執行計算。

• 基本上，將由左至右執行計算。
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• 括弧內的表示式具有最高優先順序。

• 以下顯示各命令的優先順序。

1 有括弧的表示式

2
含括弧的函數（右邊帶有引數的 sin(、log(、f(、g( 等函數、

引數後帶有右括弧的函數）

3
輸入值之後的函數（x2、x3、x-1、x!、°’ ”、°、r、g、%、

t）、工程符號（m、μ、n、p、f、k、M、G、T、P、E）、乘

方（ ）、方根（ ）

4 分數

5 負號 ((-))、Base Prefix (d、h、b、o)

6
單位轉換命令（cm   in 等）、Statistics 應用程式估計值 
（x̂  、 ŷ、x̂1、x̂2）

7 省略乘法符號的乘法

8 排列（nPr），組合（nCr），複數極座標符號（∠）

9 內積 (•)

10 乘法 (×)、除法 (÷)

11 加法 (+)、減法 (−)

12 and (邏輯運算子)

13 or、xor、xnor (邏輯運算子)

如果計算包含負數，可能需要為負數加上括弧。如果想對負數求平方（例如

-2），您需要輸入：(-2)2。這是因為 x2 是一個函數，前面有一個值（上方

的優先順序 3），其優先順序大於負號，即前綴符號（優先順序 5）。

範例：

((-))2 -22 = -4
((-))2 (-2)2 = 4

計算範圍、數字位數和精確度

計算範圍和數字位數用於內部計算，而計算精確度取決於您所執行的計算類

型。
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計算範圍和精確度

計算範圍 ±1 × 10-99 至 ±9.999999999 × 1099 或 0

內部計算的數字位數 23 位

精確度

一般而言，單一計算的精確度為第 10 位數

字 ±1。指數顯示的精確度為最小有效數字

位 ±1。在連續計算中，誤差會累積。

函數計算輸入範圍和精確度

函數 輸入範圍

sinx
cosx

Degree 0 ≤ |x| < 9 × 109

Radian 0 ≤ |x| < 157079632.7

Gradian 0 ≤ |x| < 1 × 1010

tanx

Degree
和 sinx 相同，除了 |x| = (2n -
1) × 90 之外。

Radian
和 sinx 相同，除了 |x| = (2n -
1) × π/2 之外。

Gradian
和 sinx 相同，除了 |x| = (2n -
1) × 100 之外。

sin-1x、cos-1x 0 ≤ |x| ≤ 1

tan-1x 0 ≤ |x| ≤ 9.999999999 × 1099

sinhx、coshx 0 ≤ |x| ≤ 230.2585092

sinh-1x 0 ≤ |x| ≤ 4.999999999 × 1099

cosh-1x 1 ≤ x ≤ 4.999999999 × 1099

tanhx 0 ≤ |x| ≤ 9.999999999 × 1099

tanh-1x 0 ≤ |x| ≤ 9.999999999 × 10-1

logx、lnx 0 < x ≤ 9.999999999 × 1099
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10x -9.999999999 × 1099 ≤ x ≤ 99.99999999

√x 0 ≤ x < 1 × 10100

x2 |x| < 1 × 1050

x-1 |x| < 1 × 10100；x ≠ 0

x! 0 ≤ x ≤ 69 (x 為整數)

nPr
0 ≤ n < 1 × 1010，0 ≤ r ≤ n (n、r 為整數)
1 ≤ {n!/(n - r)!}< 1 × 10100

nCr
0 ≤ n < 1 × 1010，0 ≤ r ≤ n (n、r 為整數)
1 ≤ n!/r!< 1 × 10100 或 1 ≤ n!/(n - r)!< 1 × 10100

Pol(x, y)
|x|, |y| ≤ 9.999999999 × 1099

√x2 + y2 ≤ 9.999999999 × 1099

Rec(r, θ)
0 ≤ r ≤ 9.999999999 × 1099

θ：和 sinx 相同

a°b’c”
|a|, b, c < 1 × 10100；0 ≤ b, c
秒的顯示值誤差為第二小數位 ±1。

a°b’c” = x
0°0’0” ≤ |x| ≤ 9999999°59’59”
超出上述範圍的六十進位值，會自動視為十進位

值。

xy

x > 0：-1 × 10100 < ylogx < 100
x = 0：y > 0

x < 0：y = n， m
2n + 1 (m、n 為整數)

但是：-1 × 10100 < ylog |x| < 100

x
√y

y > 0：x ≠ 0，-1 × 10100 < 1/x logy < 100
y = 0：x > 0

y < 0：x = 2n + 1，2n + 1
　 m　

 (m ≠ 0；m、n 為整數)

但是：-1 × 10100 < 1/x log |y| < 100

a b/c
所有整數、分子和分母都必須不超過十位數（包括

分隔符號）。

RanInt#(a, b) a < b；|a|，|b| < 1 × 1010；b - a < 1 × 1010

132



• 如上述「計算範圍和精確度」中所述，精確度基本上是相同的。

• xy、
x
√y、x!、nPr、nCr 類型函數需要連續的內部計算，這可能會導致每次

計算時出現的錯誤累積。

• 誤差會累積，而且在函數的奇點（奇異點）或拐點（轉折點）附近，誤差

會相對較大。

• 在 SETTINGS 選單上，將 MathI/MathO 選擇作為 Input/Output 時，能夠

以 π 格式顯示的計算結果的範圍為 |x| < 106。請注意，該內部計算錯誤可

能會使其以 π 格式顯示部分的計算結果。還可能會導致應為小數格式的計

算結果以 π 格式顯示。

規格

fx-570CW
電源規格：

AAA 型電池 R03 × 1

預計電池壽命：

2 年（以每天工作一小時計算）

能量消耗：

0.0008 W

操作溫度：

0°C 到 40°C

尺寸：

13.8 (高) × 77 (寬) × 162 (長) mm

大概重量：

100 g，包括電池

fx-991CW
電源規格：

內建太陽能電池；鈕型電池 LR44 × 1

預計電池壽命：

2 年（以每天工作一小時計算）

操作溫度：

0°C 到 40°C

尺寸：

10.7 (高) × 77 (寬) × 162 (長) mm
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大概重量：

95 g，包括電池
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常見問題

常見問題

■ 如何將除法操作所產生的分數形式結果變更為小數形式？

→ 當顯示分數計算結果時，按下  並選擇 [Decimal]，或按下 
( )。若要將計算結果預設顯示為小數值，請將 SETTINGS 選單上的

Input/Output 設定變更為 MathI/DecimalO。

■ Ans 儲存器和變數儲存器之間的差異為何？

→ 這些儲存器類型扮演著類似「容器」的角色，以暫時儲存單一值。

Ans 儲存器：儲存上一次執行的計算結果。使用此儲存器將某個計算的

結果帶入下一個計算中。

變數：此儲存器在您需要在一或多個計算中，多次使用相同值時會很有幫

助。

■ 如何在本計算器上找到舊型 CASIO 計算器所使用的函數？

→ 本計算器的函數可從按下  時顯示的 CATALOG 選單中存取。如需詳

細資訊，請參閱下列章節。

「使用 CATALOG 選單」（第 23 頁）

「進階計算」（第 42 頁）

■ 在舊型 CASIO 計算器上，我按下了  變更計算結果顯示格式。如何在

本計算器上執行此操作？

→ 當顯示計算結果時，按下 。使用顯示的選單選擇您要的顯示格式。如

需詳細資訊，請參閱「變更計算結果格式」（第 36 頁）。

■ 如何找到我目前使用的計算器應用程式？

→ 按下 。這會反白顯示您目前使用之計算器應用程式的圖示。

■ 如何計算 sin2 x

→ 例如，若要計算 sin2 30 =  1
4 ，請輸入以下計算。

30

■ 為何無法輸入 (i) 或計算複數？

→ 您無法使用 Calculate 應用程式輸入 i 或執行複數計算。使用 Complex
應用程式執行這類計算。

■ 為何剛開啟計算器就顯示電池圖示（ ）？
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→ 電池圖示表示電池電力不足。如果看見此圖示，請盡快更換電池。如需

電池更換的詳細資訊，請參閱「更換電池」（第 128 頁）。

■ 如何讓計算器返回到其初始的預設值？

→ 執行下列程序以初始化計算器設定（不包括 Contrast 和 Auto Power
Off）。

(1) 按下 ，選擇計算器應用程式圖示，然後按下 。

(2) 按下 ，然後選擇 [Reset] > [Settings & Data] > [Yes]。
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